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1 Bienvenue dans REAKTOR
 

REAKTOR est un instrument de musique. Il crée des sons. Vous pouvez l'utiliser comme 
n'importe quel autre logiciel de musique – en mode autonome avec un clavier MIDI ou en
plug-in dans un séquenceur hôte.
La différence est que vous définissez ici le type d'instrument dont il s'agit. À chaque fois 
que vous lancez REAKTOR, le logiciel s'adapte à vos besoins musicaux. Vous avez besoin 
d'un synthétiseur ? D'une boîte à rythme ? De ce générateur de bruit si particulier que            
vous n'aviez encore jamais entendu ? Chargez simplement le fichier de l'instrument corres
pondant, et le tour est joué.
La version complète de REAKTOR est livrée avec 50 instruments. En outre, la collection 
des instruments issus des versions précédentes de REAKTOR rassemble plus de dix an­
nées d'expériences en musique électronique. La bibliothèque en ligne ajoute à cela plus 
de 3000 instruments de tous les types imaginables.
Même si vous ne possédez pas la version complète, vous pouvez utiliser la puissance mu­
sicale du moteur de REAKTOR. Un ensemble toujours plus grand d'Instruments KOMPLE­
TE est également disponible pour REAKTOR. Lorsque vous chargez l'un de ces instru­
ments, REAKTOR passe en mode Player. Vous en saurez plus à la section ↑1.2, Modes de 
REAKTOR : Full, Player et Demo.
Cependant, le chargement d'instruments pré-configurés ne revient qu'à gratter la surface. 
Vous pouvez modifier le traitement du signal dans votre instrument favori, adapter sa 
structure interne aux besoins d'un morceau spécifique ou encore construire votre propre 
instrument à partir de zéro, créant ainsi un son portant votre signature personnelle.
Ce document vous aidera à débuter.
L'équipe REAKTOR de Native Instruments

1.1 Configuration requise
 

Vous trouverez les informations actuelles concernant les configurations requises et la com­
patibilité avec les versions actuelles et anciennes des systèmes d'exploitation sur notre si­
te web, à la page :
www.native-instruments.com/REAKTOR

Bienvenue dans REAKTOR
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1.2 Modes de REAKTOR : Full, Player et Demo
 

Les possibilités offertes par la version de REAKTOR installée sur votre ordinateur dépen­
dent du mode dans lequel fonctionne REAKTOR. Ce mode dépend du type de licence que 
vous utilisez :

▪ Full : si vous avez déjà installé et activé REAKTOR, en produit individuel ou comme
élément d'une collection telle que KOMPLETE, vous l'utilisez en mode Full (« com 
plet »). En mode Full, toutes les fonctions sont disponibles sans aucune restriction.

▪ Player : vous avez installé et activé un Instrument KOMPLETE quelconque pour          
REAKTOR, ou encore une collection d'Instruments telle que KOMPLETE Elements. 
De plus, vous avez installé REAKTOR en tant qu'application de lecture pour ces Ins­
truments. Dans ce cas, vous utilisez REAKTOR en mode Player. En mode Player, vous 
pouvez jouer sur les Instruments et modifier leurs réglages, mais vous ne pouvez pas 
modifier leur structure interne. Bien que ce mode ne vous permette pas de sauvegar­
der les Instruments, tous les réglages des Instruments sont sauvegardés avec le projet 
de l'hôte.

▪ Demo : vous avez installé REAKTOR et un certain nombre d'Instruments KOMPLETE
en versions de démonstration, mais vous n'avez encore activé aucun des produits. 
Dans ce cas, vous utilisez la licence de démonstration de REAKTOR – autrement dit,
REAKTOR fonctionne en mode Demo. En mode Demo, toutes les fonctions sont dis­
ponibles, mais l'application arrête toute production de son après 30 minutes. En ou­
tre, la sauvegarde est désactivée.

L'installation et l'activation sont détaillées dans le document distinct Guide d'Installation de 
Native Instruments.

1.3 Comment débuter
 

Ce document vous explique toutes les étapes nécessaires pour débuter avec REAKTOR :
▪ Les chapitres ↑2, Réglages de base dans REAKTOR et ↑3, Charger et utiliser des ins­

truments écrivent comment configurer l'application et comment charger et jouer d'un 
Instrument. Cette partie de la documentation concerne tous les utilisateurs et utilisa­
trices.

Bienvenue dans REAKTOR
Modes de REAKTOR : Full, Player et Demo

 

REAKTOR 5.5 - Prise en main - 11



▪ Les chapitres ↑4, Modifier un Ensemble REAKTOR à ↑9, Et ensuite ? expliquent des 
fonctionnalités présentes uniquement dans le mode Full de REAKTOR. Si vous utili­
sez REAKTOR en mode Player, ceci ne vous concerne pas.

Au cours des chapitres suivants, vous apprendrez à effectuer les tâches les plus commu­
nes dans REAKTOR. Sans vous bassiner avec des détails techniques, de nombreux tuto­
riels vous apprendront à utiliser efficacement les fonctionnalités de REAKTOR. Les sec­
tions ultérieures se référant aux fonctions expliquées plus tôt dans le document, nous vous 
recommandons de suivre les tutoriels dans le bon ordre.

1.4 La documentation de REAKTOR
 

Après vous être familiarisé(e) avec l'utilisation de base de REAKTOR, vous voudrez peut-
être en savoir plus. La documentation de référence de REAKTOR contient la description 
détaillée de tous les éléments et toutes les fonctions de REAKTOR :

▪ Le document Référence de l'Application explique tous les concepts de base de REAK­
TOR. Il décrit dans le détail comment utiliser l'application. Si vous souhaitez utiliser 
et comprendre les fonctionnalités de REAKTOR au-delà du niveau présenté dans ce 
document Prise en Main, le document Référence de l'Application est votre point de 
départ.

▪ Le document Instrument Reference décrit tous les instruments livrés avec REAKTOR 
dans son contenu d'usine. Lisez ce document si vous souhaitez explorer plus en détail 
les options musicales de chacun des instruments.

▪ Le document Module and Macro Reference fournit des informations détaillées sur tous 
les éléments disponibles pour la conception d'instruments dans REAKTOR. Si vous 
souhaitez sortir des sentiers battus, ce document sera votre guide.

▪ Enfin, le document Core Reference est divisé en deux parties : la première moitié est
un tutoriel détaillant le niveau Core de REAKTOR, qui vous permet de construire vos 
propres outils de traitement du signal numérique bas-niveau. La seconde moitié est 
une référence détaillée dressant la liste de tous les composants du niveau Core.

Ces documents sont surtout utiles si vous utilisez REAKTOR en mode Full. Cependant, le 
document Référence de l'Application vous permet de comprendre de manière plus appro­
fondie l'utilisation des instruments dans REAKTOR ; il peut donc être intéressant d'y jeter
un œil, même si vous n'utilisez REAKTOR qu'en mode Player.

Bienvenue dans REAKTOR
La documentation de REAKTOR
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Tous ces documents sont disponibles dans le menu Help de REAKTOR.

Au-delà des manuels livrés avec REAKTOR, vous trouverez d'autres informations en ligne :
pensez à visiter le forum d'utilisateurs de Native Instruments à l'adresse :
http://www.native-instruments.com/forum/.
La gigantesque communauté d'utilisateurs et utilisatrices de REAKTOR met de nombreu­
ses astuces à votre disposition et vous aidera également sur des questions spécifiques.

1.5 Formats spéciaux utilisés dans ce document
 

Ce manuel utilise des formats particuliers pour souligner certains points ou pour vous 
avertir de problèmes potentiels. Les icônes introduisant ces notes vous permettent de voir 
immédiatement le type d'information dont il s'agit :

Lorsque vous voyez cette icône de point d'exclamation, lisez la note attentivement et, le 
cas échéant, suivez à la lettre les instructions et conseils qu'elle contient.

Cette icône d'ampoule indique que la note contient des informations supplémentaires uti­
les. Ces informations vous aideront souvent à effectuer une tâche plus facilement, mais 
elles ne s'appliquent pas toujours à votre configuration ou à votre système d'exploitation. 
Elles sont toutefois dignes d'être lues par la plupart des utilisateurs et utilisatrices.

Bienvenue dans REAKTOR
Formats spéciaux utilisés dans ce document

 

REAKTOR 5.5 - Prise en main - 13



2 Réglages de base dans REAKTOR
 

REAKTOR 5 peut fonctionner an logiciel autonome avec sa propre interface vers votre car­
te son et votre matériel MIDI. Vous pouvez ainsi jouer sur REAKTOR depuis un clavier ou 
contrôleur MIDI relié à votre ordinateur. Dans ce qui suit, nous supposerons que vous utili­
sez REAKTOR comme application autonome.
Dans ce chapitre, vous apprendrez à relier REAKTOR aux appareils MIDI et audio connec­
tés à votre ordinateur. Vous vous familiariserez aussi quelque peu avec REAKTOR sans 
être distrait(e) par l'utilisation d'un logiciel hôte.
Avant de commencer à utiliser REAKTOR 5, il vous faut configurer ses réglages audio et 
MIDI.
Ceci ne s'applique qu'à la version autonome de REAKTOR 5, les plug-ins REAKTOR 5 hé­
ritant quant à eux des réglages audio et MIDI du logiciel hôte.

2.1 Configurer le matériel audio
 

Afin d'entendre le son généré par REAKTOR, vous devez configurer votre périphérique ma­
tériel audio (votre carte son ou votre interface audio externe) pour son utilisation avec 
REAKTOR.

Utilisez des pilotes à faible latence
Dès que possible, utilisez des pilotes à faible latence lorsque vous travaillez avec REAK­
TOR. REAKTOR fonctionne avec deux types de pilotes à faible latence :

▪ ASIO™
▪ Core Audio™ (uniquement sur les ordinateurs fonctionnant sous Mac OS® X)

Ces technologies ont été conçues pour garantir un transfert efficace entre le logiciel et le 
matériel audio ; elles sont à même d'assurer une latence suffisamment faible pour le jeu
en live, voire même une latence tout à fait négligeable.

2.1.1 Accéder à la boîte de dialogue Audio and MIDI Settings…
 

Lorsque vous lancez REAKTOR pour la première fois, la boîte de dialogue Audio and MIDI 
Settings… doit s'ouvrir automatiquement. Vous pourrez ré-ouvrir cette boîte de dialogue à 
tout moment depuis REAKTOR :

Réglages de base dans REAKTOR
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1. Cliquez sur le bouton Menu pour ouvrir le menu de l'application.

2. Sélectionnez l'entrée File > Audio and MIDI Settings… :

2.1.2 Sélectionner un périphérique matériel audio
 

Pour sélectionner le périphérique audio que vous souhaitez utiliser avec REAKTOR, faites 
comme suit :
1. Double-cliquez sur l'application REAKTOR pour la démarrer. Vous voyez apparaître la 

boîte de dialogue Audio and MIDI Settings….
2. Dans la boîte de dialogue Audio and MIDI Settings…, cliquez sur le menu Device pour 

ouvrir la liste des interfaces audio disponibles. Si un seul périphérique est présent 
dans la liste, le périphérique et le taux d'échantillonnage sont automatiquement sé­
lectionnés. Si plusieurs périphériques audio sont installés sur votre ordinateur, sélec­
tionnez celui que vous comptez utiliser avec REAKTOR en cliquant sur son entrée 
dans le menu Device.

Réglages de base dans REAKTOR
Configurer le matériel audio

 

REAKTOR 5.5 - Prise en main - 15



3. Dans le menu Driver, sélectionnez la type de pilote que vous souhaitez utiliser. Sur les 
ordinateurs fonctionnant sous un système d'exploitation Windows®, l'utilisation 
d'ASIO™ est chaudement recommandée. Sur les ordinateurs fonctionnant sous 
Mac OS® X, Core Audio™ est pré-sélectionné.

Réglages de base dans REAKTOR
Configurer le matériel audio
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Maintenant que vous avez sélectionné le périphérique audio et le pilote correspondant, 
continuez en choisissant le taux d'échantillonnage.

2.1.3 Sélectionner un taux d'échantillonnage
 

1. Dans le menu Sample Rate, sélectionnez le taux d'échantillonnage souhaité pour votre 
matériel audio. Nous vous recommandons de sélectionner la valeur 44100 Hz.

Réglages de base dans REAKTOR
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2. Maintenant que vous avez sélectionné un taux d'échantillonnage, continuez en ajus­
tant la latence de sortie.

2.1.4 Ajuster la latence de sortie
 

En ajustant la latence de sortie de votre matériel audio, vous pouvez contrôler la vitesse à 
laquelle le signal audio généré par REAKTOR devient audible une fois que vous avez ap­
puyé sur une touche de votre clavier MIDI. La quantité minimale de latence pouvant être 
atteinte sans craquement ni bruit parasite dépend de la puissance disponible sur votre 
processeur pour le traitement audio. Sur un ordinateur moderne configuré correctement, le 
délai devrait être imperceptible. Les ordinateurs plus anciens pourront nécessiter un régla­
ge de latence plus généreux. La manière dont la latence est ajustée depuis REAKTOR dé­
pend du système d'exploitation utilisé.

Réglages de base dans REAKTOR
Configurer le matériel audio
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Windows®
1. Dans la boîte de dialogue Audio and MIDI Settings…, cliquez sur le bouton ASIO Config 

pour ouvrir le panneau de contrôle de votre matériel audio.

2. Dans le panneau de contrôle de votre matériel audio, sélectionnez une latence de sor­
tie d'environ 10 millisecondes. Cette valeur devrait fonctionner correctement sur la      
plupart des ordinateurs.

Réglages de base dans REAKTOR
Configurer le matériel audio
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3. Pour confirmer les réglages effectués, cliquez sur OK.

Mac OS® X
1. En bas de la boîte de dialogue Audio and MIDI Settings…, déplacez la tirette Latency 

jusqu'à une valeur d'environ 256 échantillons (« Samples »).

Réglages de base dans REAKTOR
Configurer le matériel audio
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2. Pour confirmer les réglages effectués, cliquez sur OK.

2.1.5 Routage : assigner les entrées de REAKTOR
 

Vous pouvez assigner chacun des canaux d'entrée de REAKTOR à une entrée quelconque 
de votre matériel audio :
1. Dans la boîte de dialogue Audio and MIDI Settings…, cliquez sur l'onglet Routing, en 

haut. (Si vous utilisez Mac OS® X et souhaitez utiliser les entrées intégrées de votre
Mac, vous devrez configurer un Aggregate Device via l'utilitaire « Audio MIDI Se           
tup.app ».)

2. Cliquez sur le bouton Inputs pour afficher les entrées.
3. Pour assigner l'une des entrées de REAKTOR à une entrée de votre matériel audio, 

cliquez sur l'entrée correspondante dans la colonne de droite de l'affichage des en­
trées.

Réglages de base dans REAKTOR
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4. Pour confirmer la sélection effectuée, cliquez sur OK.

2.1.6 Routage : assigner les sorties de REAKTOR
 

Vous pouvez assigner chacun des canaux de sortie de REAKTOR à une sortie quelconque 
de votre matériel audio :
1. Dans la boîte de dialogue Audio and MIDI Settings…, cliquez sur l'onglet Routing (Si 

vous utilisez Mac OS® X et souhaitez utiliser les sorties intégrées de votre Mac, vous
devrez configurer un Aggregate Device via l'utilitaire « Audio MIDI Setup.app »).

2. Cliquez sur le bouton Outputs pour afficher les entrées.
3. Pour assigner l'une des sorties de REAKTOR à une sortie de votre matériel audio, cli­

quez sur l'entrée correspondante dans la colonne de droite de l'affichage des sorties.
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4. Pour confirmer la sélection effectuée, cliquez sur OK.

2.2 Configurer le matériel MIDI
 

1. Dans la boîte de dialogue Audio and MIDI Settings…, cliquez sur l'onglet MIDI. Encore une 
fois, vous aurez à votre disposition un certain nombre d'options selon le matériel con­
necté à votre ordinateur.

2. Cliquez sur le label Off à droite du périphérique que vous souhaitez utiliser. Le label 
doit se transformer en On pour chaque élément que vous activez.
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3 Charger et utiliser des instruments
 

Dans ce tutoriel, nous allons vous montrer comment charger et jouer sur des instruments 
existants.

▪ Nous vous montrerons comment utiliser le Browser de REAKTOR pour ouvrir des En­
sembles de REAKTOR.

▪ Nous présenterons les Snapshots.
▪ Enfin, nous verrons comment sauvegarder votre travail.

Ce tutoriel part du principe que vous avez installé REAKTOR ainsi que la REAKTOR Facto­
ry Selection, une collection d'Instruments KOMPLETE disponible gratuitement. De plus, 
nous supposons que vous utilisez REAKTOR comme plug-in dans votre séquenceur hôte 
favori.

Si vous possédez une licence complète de REAKTOR, vous n'avez pas besoin d'installer la 
REAKTOR Factory Selection : Carbon 2, l'instrument utilisé comme exemple, est disponible 
dans le contenu d'usine de REAKTOR, dans la section New Additions > Synthesizers.

3.1 Quelques boutons importants
 

Avant de commencer, il est important de vous familiariser avec quatre boutons très impor­
tants situés dans la Main Bar et dans le Sidepane.

▪ Le bouton Sidepane, dans la Main Bar, sert à ouvrir et fermer le Sidepane. Le Sidepane 
accueille les onglets Browser, Snapshot, Panelsets et Properties.

Fig. 3.1 Le bouton Sidepane.

▪ Cliquez sur l'onglet Browser pour ouvrir le Browser, qui sert à trouver les fichiers dans 
REAKTOR.

Fig. 3.2 L'onglet Browser.
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▪ Cliquez sur le bouton Snapshot pour ouvrir l'onglet Snapshot, qui permet de charger, 
sauvegarder et mélanger les presets.

Fig. 3.3 Le bouton Snapshot.

▪ Désormais, nous utiliserons exclusivement le bouton Menu pour accéder au menu glo­
bal. Cependant, toutes les entrées de ce menu sont également accessibles depuis le 
menu de l'application.

Fig. 3.4 Le bouton Menu.

Fig. 3.5 Le menu File de l'application (ici sur Windows®).
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Vous avez accès à tous les affichages de REAKTOR depuis les entrées du sous-menu View 
dans le menu global. Par souci de concision, nous ne le mentionnerons que dans cette partie 
du manuel de Prise en Main.

Nous utiliserons ces boutons durant le tutoriel. Utilisons maintenant le Browser pour char­
ger notre premier Ensemble REAKTOR.

3.2 Ensembles, Instruments et Instruments KOMPLETE
 

En plus des boutons, il est important de comprendre les termes suivants, utilisés dans la 
communauté REAKTOR et récurrents dans les tutoriels de ce document :

▪ L'Ensemble est un assortiment d'Instruments pouvant être chargés directement dans 
REAKTOR. Il peut s'agir d'un simple synthétiseur ou d'une tranche de canal complète 
avec divers effets. Les Instruments sont connectés entre eux ainsi qu'aux entrées et 
sorties audio de l'application. Lors de la sauvegarde, il est courant d'utiliser le format 
de fichier de l'Ensemble.

▪ L'Instrument est une partie d'un Ensemble, par exemple une unité d'effet de délai. 
Vous pouvez charger des Instruments dans un Ensemble pour les connecter aux en­
trées et sorties audio de l'application.

▪ L'Instrument KOMPLETE est le seul fichier que vous puissiez utiliser avec une licence 
Player. Techniquement proche d'un Ensemble (il est connecté aux entrées et sorties, 
par exemple), il est appelé Instrument car il s'agit d'une entité propre, du point de 
vue musical.

3.3 Charger Carbon 2
 

Pour commencer, nous allons ouvrir Carbon 2, un synthétiseur soustractif inclus dans la 
Factory Library de REAKTOR.

3.3.1 Ouvrir le Sidepane
 

S'il n'est pas visible au lancement de REAKTOR, vous devez ouvrir le Sidepane, qui con­
tient le File Browser de REAKTOR. Pour ouvrir et fermer le Sidepane, cliquez sur le bou­
ton Sidepane dans la Main Bar.
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Fig. 3.6 Le bouton Sidepane.

3.3.2 Ouvrir le Browser
 

Avec le Sidepane ouvert, cliquez sur l'onglet Browser, ou bien appuyez sur la touche [F5] de 
votre clavier d'ordinateur.

Fig. 3.7 L'onglet Browser.

Le Sidepane affiche alors le File Browser. Celui-ci est divisé en trois parties : en haut,            
quatre boutons vous permettent d'accéder à différents types de contenus. Au dessous, 
vous voyez une arborescence de fichiers. En bas, vous trouvez la liste des fichiers conte­
nus dans le dossier sélectionné dans l'arborescence au dessus.
Cliquez sur le bouton Player en haut du Browser. Vous voyez tous les Instruments KOMPLE­
TE installés apparaître dans la zone supérieure. Sélectionnez la REAKTOR Factory Selec­
tion en cliquant dessus.
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Fig. 3.1 Le Browser, avec la Factory Selection sélectionnée.

Le bouton près du bouton Player change de nom selon que REAKTOR est activé ou non : une
fois REAKTOR activé, il contient le contenu d'usine et affiche « Factory ». Avant que REAK
TOR ne soit activé, il affiche « Demo ». Ceci indique que REAKTOR passera en mode Demo si
vous chargez un Ensemble depuis cet emplacement.
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3.3.3 Charger un fichier
 

Depuis que vous avez sélectionné la REAKTOR Factory Selection, les Instruments inclus 
apparaissent dans la partie inférieure du Browser. Cliquez sur l'entrée Carbon 2 et glissez-
la vers la zone principale de la fenêtre de l'application. REAKTOR charge alors le fichier.

3.4 Jouer avec Carbon 2 et ses Snapshots
 

Fig. 3.2 Carbon 2 chargé dans REAKTOR PLAYER.

Carbon 2 est un synthétiseur soustractif classique avec des sections d'oscillateurs, de fil­
tres, de sources de modulation et des unités d'effets intégrées.

Consultez le document Instrument Reference pour une explication détaillée du Carbon 2, ou 
bien la documentation livrée avec la REAKTOR Factory Selection.
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3.4.1 Charger un Snapshot
 

Jouez quelques notes sur votre clavier MIDI pour vous faire une idée du son de ce synthé­
tiseur. Ensuite, modifions complètement le son en chargeant un Snapshot différent.
Un Snapshot est la terminologie de REAKTOR pour un son, preset ou patch. Chaque ins­
trument peut contenir des Snapshots ; le chargement de l'un de ces Snapshots règle cha
cun des contrôles de cet instrument sur une valeur particulière, recréant ainsi un son par­
ticulier.
Les Snapshots de Carbon 2 sont accessibles depuis le contrôle central dans la Main Bar 
de l'application.
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Fig. 3.3 Le contrôle Snapshot.

1. Cliquez sur le contrôle Snapshot pour ouvrir un menu déroulant. Ce menu contient tous 
les Snapshots de l'instrument.

2. Sélectionnez l'entrée In Deep.
3. Jouez quelques notes pour entendre la différence.
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3.5 Ajuster le son
 

Dans cette section, vous apprendrez à manipuler le son via quelques ajustements basi­
ques.

3.5.1 Changer d'effet
 

Le Snapshot In Deep utilise l'effet de délai de manière excessive pour ajouter une dimen­
sion spatiale au son. Supposons que le morceau sur lequel vous travaillez ne nécessite pas 
une telle spatialisation : désactivez l'effet en cliquant sur le bouton Delay. En lieu et place 
du délai, activez le bouton Chorus pour introduire un écartement stéréo.

Fig. 3.4 L'onglet Effects avec les effets Chorus et EQ activés.

3.5.2 Modifier le mouvement du filtre
 

Modifions également le mouvement du filtre.
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1. Pour manipuler le mouvement du filtre, passez la partie droite de l'instrument sur la 
section Source via l'onglet correspondant.

2. Sélectionnez LFO1 dans la partie inférieure de la section Source, encore une fois via 
l'onglet correspondant.

3. Cliquez sur le curseur Rate et glissez-le vers le haut pour augmenter la valeur du con­
trôle jusqu'à 8.

4. Jouez une note : la vitesse de déplacement du filtre a doublé.

Fig. 3.5 La section LFO de l'onglet Source, une fois les modifications effectuées.

3.5.3 Modifier les réglages du filtre
 

Pour modifier le filtre lui-même, faites comme suit :
1. Dans la section Filter au centre de l'instrument, cliquez sur le curseur Resonance et 

glissez-le vers le haut jusqu'à la valeur 0.5. Ceci rend le mouvement plus audible.
2. Rendez le son plus clair en augmentant la valeur du paramètre Cutoff, à nouveau en 

cliquant sur le curseur puis en glissant la souris vers le haut.
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Fig. 3.6 La section Filter une fois les modifications effectuées.

3.6 Sauvegarder vos réglages
 

Il y a deux moyens de sauvegarder les modifications effectuées sur le son :
▪ Sauvegarder votre fichier projet dans l'hôte : c'est la méthode la plus commune lorsque

vous faites de la musique, et également la seule méthode si vous utilisez REAKTOR 
en mode Player. Lors de l'enregistrement, votre application hôte demandera au plug-
in REAKTOR toutes les informations nécessaires pour retrouver les bons réglages, qui 
seront ainsi sauvegardés avec votre projet dans l'hôte. Lorsque vous chargerez à nou­
veau ce projet, REAKTOR recréera l'état actuel.
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▪ Sauvegarder le fichier Ensemble : ceci est uniquement possible si vous utilisez la li     
cence complète de REAKTOR (mode Full). Dans ce cas, vous créez une copie modi­
fiée du fichier que vous aviez chargé dans ce tutoriel. Vous pourrez alors réutiliser le 
son modifié dans un morceau différent en chargeant l'instrument modifié au lieu de 
l'instrument original.

Veuillez consulter la documentation de votre application hôte pour plus de détails sur la sau­
vegarde des projets dans l'hôte.

Pour sauvegarder le fichier Ensemble en tant que copie de l'instrument original, sélection­
nez l'entrée Save As… dans le menu de l'application. Ceci ouvre une fenêtre standard per­
mettant de sélectionner un dossier et un nom de fichier. Une fois l'emplacement choisi et 
le nouveau nom de fichier saisi, cliquez sur le bouton Save.
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4 Modifier un Ensemble REAKTOR
 

Dans ce tutoriel :
▪ Nous allons modifier un Ensemble REAKTOR existant intitulé Junatik. Junatik com­

prend un Instrument Synth et un Instrument Delay.
▪ Nous insérerons un Instrument Reverb dans la Structure et nous le connecterons au 

Synth.
▪ Nous retirerons l'Instrument Delay de la Structure.
▪ Nous en apprendrons également un peu plus sur le système de Snapshots de REAK­

TOR.
▪ Nous utiliserons le Browser pour charger Junatik, mais également pour insérer l'Ins­

trument Reverb.

Si vous utilisez REAKTOR PLAYER, vous pouvez arrêter votre lecture ici.. Après avoir lu les 
chapitres 2 et 3, vous êtes fin prêt(e) !

4.1 Récapitulatif
 

Dans le premier tutoriel, nous avons appris à créer et sauvegarder un Snapshot via le bou­
ton Append. Nous avons également sauvegardé notre travail via la commande Save En­
semble As…. Comme nous utiliserons à nouveau ces procédures, nous vous conseillons de 
jeter un œil au premier tutoriel avant de continuer.

Utiliser les boutons de REAKTOR
Pour récapituler, dans le tutoriel précédent, nous avons utilisé :

▪ Cliquez sur le bouton Sidepane dans la Main Bar pour ouvrir et fermer le Sidepane. Le 
Sidepane accueille les onglets Browser, Snapshot, Panelsets et Properties.

Fig. 4.1 Le bouton Sidepane.

▪ Un clic sur l'onglet Browser ouvre le Browser.
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Fig. 4.2 L'onglet Browser.

▪ Un clic sur l'onglet Snapshot ouvre la liste de Snapshots.

Fig. 4.3 L'onglet Snapshot.

Dans ce tutoriel, nous allons découvrir les Properties de REAKTOR. Nous apprendrons 
également à utiliser le bouton Structure.

▪ Un clic sur l'onglet Properties permet d'ouvrir les Properties des Ensembles, Instru­
ments, Macros, Modules et autres éléments de REAKTOR.

Fig. 4.4 L'onglet Properties.

▪ Un clic sur le bouton Structure permet d'ouvrir la Structure de REAKTOR.

Fig. 4.5 Le bouton Structure.

Nous vous conseillons de vous familiariser avec ces boutons et leurs icônes car ils s'avére­
ront très utiles, en particulier lorsque vous utiliserez REAKTOR en plug-in !

4.2 Utiliser le Browser pour charger l'Ensemble
 

À nouveau, nous allons utiliser le Browser pour charger l'Ensemble.
1. Cliquez sur le bouton Sidepane pour ouvrir le Sidepane.
2. Cliquez sur l'onglet Browser pour ouvrir le Browser.
3. Cliquez sur le bouton Factory pour naviguer dans la Factory Library.
4. Utilisez l'arborescence de la partie supérieure du Browser pour naviguer jusqu'à En­

sembles > Classics > Synthesizer. Vous devriez voir apparaître une liste de synthés 
dans la partie inférieure du Browser.

5. Dans la partie inférieure du Browser, double-cliquez sur Junatik pour l'ouvrir.
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Fig. 4.6 Junatik dans le Browser.

4.3 Les Instruments à l'intérieur des Ensembles
 

Dans cette section, nous allons observer la hiérarchie entre les Ensembles et les Instru­
ments de REAKTOR.
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4.3.1 Vue d'ensemble du Panel du Junatik
 

Fig. 4.7 Le synthé Junatik avec le StereoTDelay masqué.

Jetons un œil au Junatik. Vous trouverez facilement le synthé (il est intitulé Junatik). Sous 
le synthétiseur, vous voyez un objet intitulé StereoTDelay. Pour que le Panel de l'Ensem­
ble garde une taille raisonnable, les Instruments sont souvent repliés. C'est le cas du Ste­
reoTDelay dans le Junatik.

▪ Cliquez sur le bouton A dans en bas à droite pour l'ouvrir. Un clic sur le bouton — 
près des lettres A et B permet de le replier.
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Fig. 4.8 Le StereoTDelay dans toute sa splendeur.

4.3.2 La différence entre un Ensemble et un Instrument
 

Lorsque nous avions observé le 2-Osc, le Delay était intégré au synthétiseur. Ici, le Delay 
est un Instrument distinct. Dans la terminologie de REAKTOR, un Ensemble peut contenir 
plusieurs Instruments. Dans le cas qui nous occupe, il y a deux Instruments : le synthéti
seur Junatik et le StereoTDelay.
Dans la terminologie de REAKTOR, un Instrument peut être un instrument traditionnel (tel 
qu'un synthétiseur ou un échantillonneur), un effet (tel qu'un délai ou une réverbération) 
ou quoi que ce soit d'autre, comme par exemple un séquenceur ou même une simple ima­
ge.
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Fig. 4.9 L'Instrument Junatik.

Fig. 4.10 L'Instrument Delay.

Modifier un Ensemble REAKTOR
Les Instruments à l'intérieur des Ensembles

 

REAKTOR 5.5 - Prise en main - 42



Jouez quelques notes et vous entendrez le synthétiseur et le délai de concert. Modifions 
quelques Snapshots pour entendre des sons différents. Comme Junatik contient un Instru­
ment Synth et un Instrument Effect distincts l'un de l'autre, le système de Snapshots est 
légèrement différent.

4.4 Snapshot Master pour plug-in et hiérarchies de Snapshots
 

Jetez un œil tout en haut de l'Ensemble : vous y voyez un Panel intitulé Ens – Junatik.

Fig. 4.11 Le Panel de l'Ensemble.

Sur le Panel de l'Ensemble, vous voyez le Snapshot numéro 83 - Berlin ambience II.

4.4.1 Hiérarchie des Snapshots telle qu'affichée dans les Properties
 

Nous devons ouvrir les Properties afin de comprendre la hiérarchie des Snapshots. Pour ce 
faire :
1. Double-cliquez sur Ens – Junatik. Vous pouvez également cliquer sur l'onglet Properties 

dans le Sidepane.

2. Cliquez sur le bouton Function pour afficher la page Function des Properties du Juna­
tik.
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Fig. 4.12 Le bouton Function.

Fig. 4.13 Les Properties de l'Ensemble avec les options Recall by MIDI et Snapshot Master cochées.
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Observez les Properties : dans la section Snapshot, les cases Recall by MIDI et Snapshot Master for 
Plug-In sont toutes deux cochées.

4.4.2 Recall by MIDI et Snapshot Master for Plug-In
 

▪ Snapshot Master for PlugIn signifie que lorsque ces Snapshots sont modifiés par l'En­
semble (le « Master »), les Snapshots pour le Synth et pour le Delay seront également
modifiés. Autrement dit, l'Instrument Junatik et l'Instrument StereoTDelay sont escla­
ves du maître Ensemble.

▪ Recall by MIDI signifie que cet Instrument peut recevoir les messages Program Chan­
ge. Si le maître dispose de la même option et se trouve sur le même canal MIDI, le 
Snapshot du maître aura priorité.

4.4.3 Propriétés des Snapshots pour l'Instrument Junatik
 

Si vous cliquez une fois sur le Panel du Junatik, vous voyez que la case Recall by Parent 
est cochée.

Fig. 4.14 La section Snapshot des Properties de l'Instrument Junatik, avec la case Recall by Parent cochée.

Ceci confirme que les Snapshots du Panel de l'Ensemble sont bien les Snapshots Master.
Essayez de modifier quelques Snapshots et vous verrez comment les différents Snapshots 
de l'Instrument Junatik ont parfois (mais pas toujours) des Snapshots différents dans le 
StereoTDelay. Choisissons « 24 – Pointer 1 ». Notez que le Snapshot du StereoTDelay in
dique 1 - Delay off. Essayez maintenant de sélectionner d'autres Snapshots dans l'Instru­
ment Junatik.
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4.4.4 Snapshot avec un interrupteur REAKTOR éteint
 

Vous verrez que les Snapshots de l'Instrument Junatik jouent tous sans effet de délai :            
dans le Snapshot 1 du StereoTDelay, le délai est éteint – l'interrupteur    On au dessus du 
curseur Wet est désactivé.

Fig. 4.15 Le Delay est désactivé.

Les interrupteurs de ce type ne coupent pas seulement le son de l'Instrument, ils écono­
misent également des ressources processeur. Si vous utilisez l'Ensemble dans une station 
de travail audio numérique (telle qu'un séquenceur hôte) et utilisez les effets de celle-ci, il 
peut être judicieux de désactiver cet interrupteur.

4.4.5 Flexibilité des Snapshots
 

Bien sûr, si vous modifiez des Snapshots dans l'Instrument StereoTDelay, vous pourrez 
choisir différents effets de délai sans modifier quoi que ce soit au Snapshot du synthéti­
seur. Le fait d'avoir plusieurs Instruments vous permet donc de gagner en flexibilité, la 
présence d'un Snapshot Master vous permettant de modifier les Snapshots de plusieurs 
Instruments !

4.5 Échanger l'Instrument Delay avec un Instrument Reverb
 

Le synthétiseur Junatik nous plaît, mais au lieu d'un effet de délai, nous voulons essayer 
une réverbération. Nous allons donc substituer l'Instrument Delay par l'un des Instruments 
Reverb de REAKTOR.
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4.5.1 Ouvrir une Structure de REAKTOR
 

Pour ce faire, nous devons observer la Structure de l'Ensemble.
▪ Cliquez sur le bouton Structure de le Sidepane.

Fig. 4.16 Le bouton Structure.

Ceci ouvre la Structure de l'Ensemble.

Fig. 4.17 La Structure de l'Ensemble Junatik.

Comme vous pouvez le voir, le synthé Junatik est connecté au StereoTDelay. Les sorties L 
(gauche) et R (droite) du Junatik sont connectées aux entrées L et R du StereoTDelay. Les 
sorties L et R du StereoTDelay sont quant à elles connectées aux terminaux Audio Out.
Dans peu de temps, nous utiliserons le Browser pour insérer un Instrument Reverb dans la 
Structure de l'Ensemble. Il sera connecté à l'Instrument Junatik. Mais avant cela, nous de­
vons retirer le StereoTDelay de la Structure.

4.5.2 Retirer un Instrument de la Structure
 

Pour retirer le délai de la Structure de cet Ensemble :
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1. Effectuez un clic droit (Windows®) ou un [Ctrl]+clic (Mac OS® X) sur l'objet StereoT­
Delay dans la fenêtre Structure : un menu contextuel s'ouvre.

2. Placez le curseur de la souris sur l'entrée Delete du menu puis cliquez dessus. Ceci 
retire l'Instrument de la Structure.

Fig. 4.18 Suppression d'un Instrument.

L'Instrument StereoTDelay doit maintenant avoir disparu.

4.6 Utiliser le Browser pour rechercher des Instruments
 

Nous devons maintenant remplacer le Delay par un Instrument de réverbération. Nous al­
lons utiliser le Browser pour charger « SpaceMaster.ism ».
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1. Dans le Sidepane, cliquez sur l'onglet Browser pour ouvrir le Browser de REAKTOR.

2. Dans l'arborescence du Browser, naviguez jusqu'à Instruments > Effects.

3. Dans la partie inférieure du Browser, cliquez sur le Space Master 1 – Stereo.ism et glissez-
le dans la Structure. L'Instrument est inséré dans la Structure de l'Ensemble.
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Fig. 4.19 Le SpaceMaster est inséré dans la Structure.

Vous pouvez également effectuer un clic droit dans la Structure et choisir l'Instrument dans le 
menu contextuel qui s'ouvre.
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Fig. 4.20 Le Panel du SpaceMaster.

4.7 Connecter l'Instrument à la sortie Audio Out
 

Nous devons maintenant connecter le Junatik à la réverbération SpaceMaster et celle-ci 
aux terminaux Audio Out.

4.7.1 Effectuer les connexions
 

1. Cliquez sur la sortie L de l'Instrument Junatik (ou sur le petit point près d'elle), main­
tenez le bouton de la souris enfoncé et glissez la souris vers l'entrée L du SpaceMas­
ter. Ce faisant, vous voyez un câble suivre votre souris, tandis que le curseur de la 
souris se transforme en index pointeur. Lorsque vous atteignez l'entrée L du Space­
Master ou le point près d'elle, relâchez le bouton de la souris.
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2. Répétez cette procédure avec toutes les connexions – y compris entre les sorties L et
R du SpaceMaster et les entrées 1 et 2 des terminaux Audio Out.

Lorsque vous avez fini, votre Structure doit ressembler à ceci :

Fig. 4.21 Le SpaceMaster connecté au Junatik et aux sorties.

Nous devons maintenant observer à quoi ressemblent nos deux Instruments dans le Panel 
de l'Ensemble.

4.7.2 Réinitialiser les positions des Instruments dans le Panel de l'Ensemble
 

Il est maintenant possible que la procédure d'insertion ait placé le SpaceMaster au dessus 
de l'Instrument Junatik dans le Panel de l'Ensemble – si ce n'est pas le cas, sautez cette
étape. Pour modifier sa position, faites comme suit :
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1. Affichez le Panel en cliquant sur le bouton Panel dans la Sidebar.

2. Sélectionnez le Panel du SpaceMaster en cliquant sur son nom.
3. Maintenez le bouton de la souris enfoncé et glissez l'Instrument afin de le placer sous 

le Junatik, puis relâchez le bouton de la souris – il prend alors sa nouvelle place. Le
Junatik est de retour au sommet !

Fig. 4.22 Le Junatik au sommet.
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4.8 Retrouver la hiérarchie correcte des Snapshots
 

En insérant l'Instrument SpaceMaster dans la Structure, la hiérarchie des Snapshots a été 
modifiée. Nous devons effectuer quelques modifications pour récupérer la hiérarchie du 
Snapshot Master – dans laquelle l'Ensemble est le Snapshot Master for Plug-In. Nous al
lons devoir modifier les Properties des Instruments Junatik et SpaceMaster.

4.8.1 Ouvrir les Properties de l'Instrument
 

Nous devons d'abord faire à nouveau de l'Ensemble Junatik le Snapshot Master for Plug-
In, puis activer la fonction Recall by Parent pour le SpaceMaster.
1. Dans le Sidepane, cliquez sur l'onglet Properties.

2. Cliquez sur l'en-tête Ens – Junatik. Ceci ouvre les Properties de l'Ensemble Junatik.

3. Cliquez sur le bouton Function.

4. Cochez maintenant la case Snapshot Master for Plug-In, dans la section Snapshot.
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5. Cliquez maintenant sur le Panel du SpaceMaster – un clic sur son nom fait l'affaire.
Ceci ouvre les Properties du SpaceMaster.

6. Cochez la case Recall by Parent.
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5 Créer un synthétiseur séquencé
 

Dans ce tutoriel, nous allons créer un synthétiseur avec séquenceur intégré.

5.1 Plan d'action
 

Lorsque nous avons observé l'Ensemble Junatik, nous avons vu qu'il était constitué de 
l'Instrument Synth Junatik et de l'Instrument StereoTDelay. Nous allons maintenant créer 
un Ensemble qui utilise deux Instruments de REAKTOR. L'un des Instruments sera un sé­
quenceur intitulé Monoliner, et l'autre un synthétiseur appelé Soundschool Analog (ou 
ANALOG pour faire court).
Le Monoliner émule les séquenceurs à pas analogiques classiques avec trois lignes de cur­
seurs, tandis que le Soundschool Analog est un synthétiseur classique de type analogique, 
semi-modulaire à deux oscillateurs.
Nous effectuerons les connexions nécessaires – audio et MIDI – afin que le séquenceur  
pilote le synthé.
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Fig. 5.1 Le Monoliner et le Soundschool Analog (ANALOG).

5.2 Créer l'Ensemble synthétiseur-séquenceur
 

Nous allons commencer avec un nouvel Ensemble puis y insérer les Instruments.

5.2.1 Créer un nouvel Ensemble
 

▪ Créez un nouvel Ensemble en cliquant sur le bouton Menu puis en sélectionnant l'en­
trée File > New Ensemble.
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Fig. 5.2 L'entrée New Ensemble dans le menu global.

Fig. 5.3 Le Panel du nouvel Ensemble.

Vous pouvez également utiliser le raccourci clavier [Ctrl]+[N] (Windows®) ou [Cmd]+[N] 
(Mac OS® X) pour créer un nouvel Ensemble.

5.2.2 Utiliser le Browser pour charger les Instruments
 

1. Dans le Sidepane, cliquez sur l'onglet Browser pour ouvrir le Browser.
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2. Cliquez sur le bouton Factory pour ouvrir la Factory Library.

3. Puis, via l'arborescence du Browser, naviguez vers Instruments > Sequencers.
4. Glissez le Monoliner.ism depuis la partie inférieure du Browser vers le Panel sur la droi­

te. Ceci insère le Monoliner dans votre Ensemble.
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Nous allons maintenant utiliser le Browser pour charger le Soundschool Analog.
1. Via l'arborescence, naviguez vers Instruments > Synthesizers.
2. Faites défiler la liste vers le bas jusqu'à trouver Soundschool Analog.ism.
3. Cliquez sur Soundschool Analog.ism et glissez-le vers le Panel sur la droite.
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Fig. 5.4 Insertion du Soundschool Analog dans votre Ensemble.

5.3 Mettre le synthétiseur séquencé en état de marche
 

Nous avons besoin de câbler tout ceci et de créer les connexions MIDI du Monoliner vers 
le Soundschool Analog.
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5.3.1 Vue d'ensemble de la Structure
 

Une fois remplie, votre Structure doit ressembler à ceci :

Fig. 5.5 La Structure de l'Ensemble avec le Monoliner et l'ANALOG.

Nous pouvons voir les Instruments Monoliner et ANALOG ainsi que l'Instrument vide par 
défaut, connecté aux terminaux Audio In et Audio Out. Retirons cet Instrument de la 
Structure, nous n'en avons pas besoin.

5.3.2 Retirer l'Instrument indésirable
 

▪ Effectuez un clic droit (Windows®) ou un [Ctrl]+clic (Mac OS® X) sur l'Instrument et 
choisissez l'entrée Delete dans le menu contextuel.

Créer un synthétiseur séquencé
Mettre le synthétiseur séquencé en état de marche

 

REAKTOR 5.5 - Prise en main - 62



Fig. 5.6 Suppression d'un Instrument via le menu contextuel.

Tant que nous y sommes, connectons les sorties L et R du synthé ANALOG aux entrées 
des terminaux Audio Out 1 et 2.

5.3.3 Connecter les sorties de l'ANALOG aux sorties audio
 

Vous vous rappellerez peut-être que nous avons fait la même chose lorsque nous avons 
connecté le synthétiseur Junatik à la réverbération SpaceMaster.
1. Cliquez sur la sortie L (ou le point noir à côté), maintenez le bouton de la souris en­

foncé et glissez la souris jusqu'à l'entrée du premier terminal Audio Out (ou jusqu'au 
point noir à côté) – vous voyez un câble se dessiner –, puis relâchez le bouton de la
souris. La connexion est créée.

2. Faites de même entre la sortie R et le terminal Audio Out 2.
Votre Structure doit ressembler à ceci :
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Fig. 5.7 L'ANALOG avec ses sorties audio connectées.

Comme vous pouvez le voir, nous gardons l'Instrument Master, car il dispose d'un Master 
Level Fader bien pratique. Regardons maintenant les deux Instruments dans le Panel de 
l'Ensemble.

5.3.4 Vue d'ensemble du Monoliner et de l'ANALOG
 

▪ Pour afficher le Panel de l'Ensemble, cliquez sur le bouton Panel.

Fig. 5.8 Le bouton Panel.
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Fig. 5.9 Le Monoliner et l'ANALOG.

Comme vous pouvez le voir, le Monoliner dispose de trois lignes de curseurs contrôlant les 
paramètres Gate (porte), Velocity (vélocité) et Pitch (hauteur tonale). Sur la gauche, la 
section snc&pos contrôle la vitesse et la direction de lecture du séquenceur ainsi que le 
nombre de pas utilisés. Nous nous intéresserons plus tard aux autres contrôles. L'impor­
tant est que le Monoliner dispose d'une sortie MIDI Out intégrée !
Le synthé ANALOG est équipé de deux oscillateurs avec modulation en anneau, de deux 
enveloppes, d'un LFO et d'un délai stéréo intégré.

5.4 Effectuer les connexions MIDI entre les Instruments
 

Comme nous l'avons mentionné, le Monoliner a été programmé pour envoyer des données 
MIDI aux synthétiseurs de REAKTOR ainsi qu'aux synthétiseurs externes ! Nous devons        
créer une connexion MIDI interne dans cet Ensemble. La procédure est simple.
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5.4.1 Utiliser les connexions MIDI internes
 

Pour router en interne la sortie MIDI de l'Instrument Monoliner vers l'entrée MIDI de 
l'ANALOG, rendez-vous sur la page Connect des Properties du Monoliner.
1. Dans le Sidepane, cliquez sur l'onglet Properties.

2. Cliquez maintenant sur le bouton Connect pour ouvrir la page Connect des Properties.

3. Pour effectuer le branchement entre le séquenceur et le synthétiseur, trouvez le menu 
déroulant Select Instruments dans la section MIDI Out de cette page Connect. Cliquez sur 
le menu et sélectionnez l'entrée ANALOG.

4. Pour vérifier que la connexion a bien été effectuée, allez sur la page Connect de l'Ins­
trument ANALOG. Cliquez simplement sur l'en-tête de l'Instrument ANALOG pour le 
sélectionner.
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5. La page Connect de l'ANALOG devrait maintenant apparaître dans le Sidepane. Cli­
quez sur le menu déroulant Select Instruments dans la section MIDI In de cette page Con­
nect. Vous noterez que la case près de l'entrée Monoliner du menu est maintenant co­
chée.

6. Sauvegardez maintenant votre travail en sélectionnant la commande Save Ensemble 
As… dans le menu global. Ça y est, vous pouvez maintenant essayer la combinaison 
séquenceur/synthétiseur !

5.5 Les boutons Run et Stop de REAKTOR
 

Les boutons Run et Stop de REAKTOR permettent de lancer et d'interrompre le séquenceur.

Vue d'ensemble des boutons Run et Stop
Les boutons Run et Stop se trouvent dans la Main Toolbar, en haut de l'Instrument, près du 
champ BPM.
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Fig. 5.10 BPM/Run/Stop

▪ Pour lancer le séquenceur, cliquez sur le bouton Run avec votre souris. Le séquenceur 
commence sa course et vous le voyez évoluer. Les diodes d'activité MIDI vous confir­
ment également que la connexion MIDI est établie. Vous devriez également entendre 
des sons sortir de votre synthétiseur !

Fig. 5.11 Les diodes d'activité MIDI.
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Interrompre et réinitialiser le séquenceur
▪ Lorsque le séquenceur est en cours de lecture, un simple clic sur le bouton Run met 

la séquence en pause – elle reprendra depuis cette position lorsque vous cliquerez à
nouveau sur Run. Un clic sur le bouton Stop réinitialise le séquenceur (il est ramené au 
début du motif).

5.6 Observer le Monoliner d'un peu plus près
 

Attardons-nous un peu sur les contrôles de vitesse et de direction.

5.6.1 Changer la direction et la vitesse
 

Ce séquenceur est très flexible en termes de lecture des motifs (patterns).
▪ Pour changer la direction d'avant en arrière et introduire des composantes aléatoires 

dans la lecture, ouvrez la liste direction en cliquant sur la flèche pointant vers le bas. 
Vous pouvez également modifier la vitesse en cliquant sur le menu sync.

Fig. 5.12 Direction.
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Fig. 5.13 Vitesse.

La valeur par défaut (1/16) divise une mesure en double-croches (1/16ème de ronde).

5.6.2 Nombre de pas, décalage des pas et swing
 

▪ Le curseur stps permet de modifier le nombre total de pas – entre 1 et 16.
▪ Le curseur offs décale le point de départ de la séquence.
▪ SHFL (pour « Shuffle ») ajoute du swing à la lecture. Essayez de passer le nombre de

pas à 6 puis décalez le point de départ jusqu'au pas n° 9.

5.6.3 Les curseurs GATE, VELOCITY et PITCH et les boutons On/Off
 

▪ La ligne supérieure de curseurs – intitulée GATE – permet de spécifier la durée de cha
que déclenchement.

▪ Le curseur tout au bout est le Master et affecte l'ensemble des durées Gate.
▪ La ligne suivante – intitulée VELO – spécifie le volume (la vélocité) de chaque déclen

chement. Là aussi, vous trouvez un volume Master.
▪ La ligne de curseurs inférieure – intitulée PITCH – sert à définir les pitches (hauteurs

tonales).
▪ La ligne de boutons contrôle les Gate On et Off.

Créer un synthétiseur séquencé
Observer le Monoliner d'un peu plus près

 

REAKTOR 5.5 - Prise en main - 70



Fig. 5.14 Les curseurs Master.

Fig. 5.15 Les boutons Gate On/Off.

5.7 Explorer les Snapshots et afficher les Hints
 

Explorons un peu cette combinaison séquenceur/synthétiseur.

5.7.1 Explorer les Snapshots du Monoliner et de l'ANALOG
 

Le Monoliner est livré avec seulement quelques Snapshots mais ils valent la peine d'être 
essayés ! Ce séquenceur devient vraiment amusant lorsque vous changez la direction, le  
nombre de pas et le décalage dans la section snc&pos, créant ainsi de multiples varia­
tions. Vous pouvez également rendre les réglages aléatoires en cliquant sur le bouton rnd!. 
Le synthé ANALOG dispose lui aussi de quelques Snapshots, et le changement de Snaps­
hot lorsque la séquence est en cours de lecture peut s'avérer très efficace.

5.7.2 Show/Hide Hints
 

Encore une fois, nous vous suggérons de vérifier que les Hints (astuces) sont activées en cli­
quant sur le bouton Hints. Notamment, vous découvrirez que le synthétiseur dispose de quel­
ques informations très utiles, qui apparaîtront lorsque vous survolerez les curseurs et interrup­
teurs avec la souris :
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Fig. 5.16 Les informations pour le curseur FM.

Après avoir exploré l'Ensemble, pensez à sauvegarder à nouveau votre travail !
Souvenez-vous : vous pouvez utiliser la commande Save Ensemble du menu global si vous 
souhaitez écraser la version que vous aviez précédemment enregistrée. Vous pouvez sinon 
utiliser la commande Save Ensemble As… si vous souhaitez conserver l'ancienne version 
et sauvegarder la nouvelle sous un nom différent.
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6 Explorer un sampler de REAKTOR
 

Dans ce tutoriel, nous allons nous pencher sur Memory Drum 2, qui est un lecteur de sam­
ples (échantillons) très utile pour les samples de batterie.

6.1 Plan d'action
 

Nous avons jusqu'ici exploré deux des synthétiseurs de la Library de REAKTOR ; il est             
temps de jeter un œil sur l'un de ses lecteurs de samples.

▪ Nous allons apprendre à remplacer l'un des samples dans la Sample Map (table d'as­
signation) par l'un de nos samples.

▪ Nous apprendrons également à ajouter un sample à la Sample Map.
▪ Nous observerons comment sélectionner les samples dans la Sample Map via un cla­

vier MIDI, et comment les écouter avec la souris.
▪ Nous nous pencherons également sur l'assignation des samples dans REAKTOR.
▪ Enfin, nous survolerons rapidement certaines des fonctions spéciales du Memory 

Drum.
Encore une fois, nous allons d'abord utiliser le Browser pour charger le Memory Drum 2.
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Fig. 6.1 Le Memory Drum 2.

6.2 Utiliser le Browser pour charger le Memory Drum 2
 

1. Dans le Sidepane, cliquez sur l'onglet Browser pour ouvrir le Browser.
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2. Dans l'arborescence, naviguez vers Ensembles > New Additions > Sample Player.
3. Double-cliquez sur MemoryDrum2.ens pour charger l'Ensemble.

Fig. 6.2 Sélection du Memory Drum 2 dans le Browser.

Le Memory Drum 2 est assigné de façon à ce que la note C1 joue le premier sample et 
que chaque demi-ton joue un nouveau son. Avant tout, explorons les sons en jouant diffé­
rentes notes sur le clavier. Même si vous appréciez les samples en place, vous voudrez 
peut-être les remplacez par des samples de votre crû. Pour ce faire, nous devons ouvrir le 
Sample Map Editor.
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6.3 Remplacer et éditer les samples dans le Sample Map Editor
 

Nous allons utiliser le Sample Map Editor pour remplacer les samples. Nous allons ouvrir 
la Sample Map (table d'assignation), utiliser SEL BY KEY afin de pouvoir sélectionner les 
samples dans la table depuis notre clavier MIDI, et utiliser notre souris pour auditionner 
les samples.

6.3.1 Ouvrir la Map et jouer les samples
 

1. Double-cliquez sur la forme d'onde du sample. Le Sample Map Editor s'ouvre. Vous 
pouvez également cliquer sur le bouton Sample Map dans la Sidebar, ou encore utiliser 
le raccourci clavier [F9].

2. Activez la fonction Select Sample by Key en cliquant sur le bouton Key, situé en haut 
à droite de la Sample Map. Vous pouvez désormais sélectionner les samples depuis 
votre clavier MIDI.
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3. Cliquez sur le bouton Sample Prehear pour entendre les samples sous leur forme origi­
nale.

Fig. 6.3 Le bouton Sample Prehear.

Remplaçons quelques samples avec nos propres samples. Remplaçons le sample de caisse 
claire de la note MIDI 48. Commençons par le sélectionner en appuyant sur la note C2 de 
notre clavier MIDI.

6.3.2 Utiliser Replace dans l'Edit Sample List
 

▪ Ouvrez le menu déroulant Edit en haut à gauche du Sample Map Editor et sélection­
nez l'entrée Replace dans ce menu.
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Fig. 6.4 L'entrée Replace remplace le sample sélectionné.

Un dossier doit s'ouvrir – celui-là même que nous avons sélectionné dans les Preferences
de REAKTOR pour les fichiers audio. Dans notre exemple, nous avons remplacé le sample 
de caisse claire placé sur la note MIDI 48.

6.3.3 Key-Split et Root Note du sample
 

Observons le sample d'un peu plus près.

Fig. 6.5 Le sample Clap CloseTheBook.wav tel qu'il apparaît dans le Sample Map Editor.
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L et R ont tous deux une valeur de 48. Ceci signifie que le Key-Split (la séparation du cla­
vier) de ce sample se limite à une seule note, la note MIDI 48, ce qui est adapté à un son 
de percussion. La Root Note (note de base) est également réglée sur 48. Ceci signifie que 
le sample sera lu à sa hauteur originale lorsque la note MIDI 48 sera jouée.
Nous avons simplement remplacé un sample, nous allons maintenant ajouter un nouveau 
sample à la table d'assignation.

6.3.4 Utiliser Add dans l'Edit Sample List
 

1. Faites défiler la liste vers le bas jusqu'au dernier sample, assigné à la note MIDI 77 
et portant le nom Sound 9.

2. Cliquez sur le menu déroulant Edit et sélectionnez l'entrée Add.

Fig. 6.6 Ajouter un nouveau sample dans la Sample Map via l'entrée Add.
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Cette fois, le dernier dossier ouvert (lorsque nous avons remplacé l'autre sample) s'ouvre à 
nouveau. Nous pouvons soit choisir un autre sample dans ce dossier, soit naviguer vers un 
autre dossier. Derechef, double-cliquez sur le sample pour le charger dans la table.

6.3.5 Éditer le Key-Split
 

Nous allons éditer le Key-Split (séparation de clavier) afin que les valeurs L et R soient 
toutes deux égales à 78. Pour modifier une valeur :
1. Double-cliquez sur le nombre dans la ligne et la colonne souhaitées (ici, la ligne cor­

respondant à votre nouveau sample et la colonne R).
2. Saisissez un nouveau nombre.
3. Appuyez sur [Entrée] lorsque vous avez fini. Ceci facilitera l'ajout d'autres samples.

4. N'hésitez pas à ajouter d'autres samples. Lorsque vous avez fini d'éditer la Sample 
Map, cliquez simplement à nouveau sur le bouton Sample Map pour la refermer. Dans la 
section suivante, nous observerons l'interface du Memory Drum.

Fig. 6.7 Le bouton Sample Map.

6.4 L'interface du Memory Drum
 

Non seulement chaque valeur de note MIDI sélectionne un sample différent, mais elle 
peut également sélectionner des caractéristiques complètement différentes pour chaque 
Sample Slot (emplacement de sample).
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6.4.1 Changer le pitch pour un seul Sample Slot
 

Revenons au premier sample que nous avons remplacé et modifions son pitch. Le Memory 
Drum vous permet de modifier le pitch (hauteur tonale) d'un emplacement de sample par­
ticulier sans toucher aux autres emplacements.

▪ Cliquez sur la tirette p et diminuez le pitch en glissant la tirette vers le bas :

Fig. 6.8 Modification du réglage de p (pitch) pour un sample particulier.

Jouez maintenant le sample depuis votre clavier MIDI : vous devriez entendre sa hauteur
diminuée. Si vous jouez un autre son, vous remarquez qu'il est lu à sa hauteur originale. 
C'est ce qui fait la particularité de ce lecteur de samples. Chaque emplacement de sample 
peut avoir des réglages distincts pour tous ses paramètres. Essayez de modifier d'autres 
contrôles, par exemple en définissant différentes enveloppes et différents filtres pour cha­
que note.
Explorons tout ceci un peu plus en détail.
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6.4.2 Explorer les Snapshots du Memory Drum
 

Fig. 6.9 La liste des Snapshots du Memory Drum.

Le Snapshot Default contient les mêmes réglages pour tous les samples. Choisissez un au­
tre Snapshot pour voir/entendre des réglages différents. Vous noterez comment les diffé­
rentes notes déclenchent non seulement des samples différents, mais peuvent également 
avoir des réglages tout à fait différents. Vous souhaiterez peut-être ajouter d'autres sam­
ples et modifier les réglages avant de sauvegarder votre version de cet Ensemble. Si vous 
effectuez des modifications dans les Snapshots, pensez bien à les enregistrer dans un 
nouveau Snapshot via le bouton Append et à renommer le Snapshot. Lorsque vous en avez 
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fini avec l'ajout / le remplacement des samples, pensez à utiliser la commande Save En­
semble As…. Si vous ne le faites pas, tout votre travail sera perdu ! Dans le tutoriel du     
chapitre ↑8, Construire un sampler avec les Modules de REAKTOR, nous nous pencherons 
également sur différentes possibilités de lecture des samples, comme par exemple la lec­
ture à l'envers, d'avant en arrière ou encore d'avant en arrière à l'envers (!). Nous appren­
drons également à transposer les samples dans le Sample Map Editor.
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7 Construire un synthétiseur à partir de Macros
 

Dans ce tutoriel, nous allons construire un synthétiseur de type analogique à partir de Ma­
cros issues de la Factory Library. Le synthétiseur aura deux oscillateurs, un mixeur, deux 
modeleurs d'enveloppes et un filtre. Nous supposons que vous avez déjà suivi les tutoriels 
précédents, qui détaillent un certain nombre de techniques concernant entre autres l'in­
sertion et la connexion.

7.1 Qu'est-ce qu'une Macro ?
 

REAKTOR dispose d'une bibliothèque complète de Macros pré-construites. Une Macro 
contient un groupe de Modules déjà connectés entre eux et rassemblés dans un Module 
proposant uniquement les entrées et sorties nécessaires. Une Macro est un peu comme un 
Instrument, mais en plus petit. Et elle ressemble aussi à un Module, mais elle est taillée 
pour construire des oscillateurs, filtres, modeleurs d'enveloppes, délais, etc. plus comple­
xes, que vous trouveriez par exemple dans des synthétiseurs modulaires. Lorsque vous 
commencez à construire des Instruments plus complexes, il est judicieux de concevoir vos 
idées en tant qu'objets et de regrouper dans des Macros les Modules ayant entre eux une 
relation particulière.
Ci-dessous, dans le synthétiseur achevé, vous pouvez distinguer les différentes Macros grâ­
ce aux lignes et aux titres autour des contrôles.
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Fig. 7.1 Le synthétiseur achevé.

La Macro Oscillator 1 contient trois oscillateurs dans sa Structure ainsi que les contrôles 
Pitch, Fine, P-Width et un commutateur Wave. Il s'agit de Modules individuels connectés 
entre eux et placés dans un petit « dossier » que nous nommons Macro.
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Fig. 7.2 La Structure de la Macro Oscillator.

Les concepteurs avertis sélectionneront souvent des parties d'un Ensemble qui ont une fonc­
tion précise et les retireront de l'Ensemble pour les insérer dans une nouvelle Macro, qu'ils 
réinséreront alors dans l'Ensemble, pour plus de clarté et pour pouvoir réutiliser la Macro dans 
d'autres contextes.

7.2 Préparatifs
 

Nous devons commencer par charger un nouvel Ensemble, y supprimer l'Instrument par 
défaut et y insérer un Instrument approprié pour la tâche que nous voulons accomplir.

7.2.1 Charger un nouvel Ensemble
 

Commençons avec le nouvel Ensemble par défaut de REAKTOR.
1. Cliquez sur le bouton Menu et sélectionnez l'entrée File > New Ensemble.
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Vous voyez apparaître le Panel l'Ensemble.

Fig. 7.3 Le Panel du nouvel Ensemble.

▪ Cliquez sur le bouton Structure pour afficher sa Structure.

Fig. 7.4 Le bouton Structure.
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Fig. 7.5 La Structure d'un nouvel Ensemble.

Nous allons commencer par nous intéresser à la Structure.

7.2.2 Retirer l'Instrument par défaut
 

Comme notre synthétiseur n'aura qu'une seule sortie, nous n'avons pas besoin de l'Instru­
ment par défaut proposant deux sorties (L et R).

▪ Pour supprimer l'Instrument par défaut, effectuez un clic droit (Windows®) ou un 
[Ctrl]+clic (Mac OS® X) sur l'Instrument et sélectionnez l'entrée Delete dans le menu 
contextuel.
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Fig. 7.6 Suppression de l'Instrument par défaut.

Nous devons maintenant insérer un Instrument adapté au synthétiseur, un Instrument qui 
n'ait qu'une seule sortie, puisque notre synthétiseur sera mono et non stéréo.

7.2.3 Insérer un nouvel Instrument
 

▪ Pour insérer un nouvel Instrument, effectuez un clic droit (Windows®) ou un [Ctrl]
+clic (Mac OS® X) sur une zone vide de la Structure de l'Ensemble pour ouvrir le me­
nu contextuel. Dans ce menu, choisissez l'entrée Insert Instrument > _New – 1in1out.
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Fig. 7.7 Insertion d'un nouvel Instrument.

L'Instrument que nous venons d'insérer dispose d'une entrée et d'une sortie.
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Fig. 7.8 L'Instrument inséré dans la Structure.

Pour notre synthétiseur, nous n'avons besoin que de la sortie ; nous allons donc supprimer
l'entrée.
1. Double-cliquez sur l'Instrument pour l'ouvrir.
2. Effectuez un clic droit (Windows®) ou un [Ctrl]+clic (Mac OS® X) sur le Module In 

pour ouvrir son menu contextuel. Sélectionnez alors l'entrée Delete dans le menu.

3. Double-cliquez sur le fond de la Structure pour revenir à son niveau supérieur.

7.2.4 Connecter l'Instrument à la sortie Audio Out
 

Nous devons connecter la sortie de l'Instrument aux terminaux Audio Out 1 et 2.
1. Placez le curseur de la souris sur Out (ou sur le petit point à côté).
2. Cliquez et maintenez le bouton de la souris enfoncé tandis que vous déplacez la sou­

ris jusqu'au port d'entrée du Module Audio Out intitulé 1.
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3. Lorsque vous atteignez l'entrée (ou le point à côté) du Module Audio Out 1, relâchez 
le bouton : vous voyez un câble connecter les deux points.

Répétez l'opération entre la même sortie unique de l'Instrument et l'entrée du Module Au­
dio Out 2. Ceci place le son sur les deux canaux de sortie gauche et droit de votre système 
audio. Vos connexions doivent ressembler à l'image suivante. La diode jaune dans le coin 
inférieur droit de l'Instrument confirme la connexion !

Fig. 7.9 L'Instrument connecté à la sortie.

7.3 Ajouter un oscillateur et une enveloppe ADSR à l'Instrument
 

Nous voulons maintenant ajouter une Macro d'oscillateur ainsi qu'une enveloppe ADSR et 
créer les connexions adéquates. Nous devons également insérer les Modules NotePitch et 
Gate, afin de pouvoir jouer sur notre synthé depuis un clavier MIDI.

7.3.1 Insérer un oscillateur
 

1. Avant tout, vérifiez que vous êtes à l'intérieur de l'Instrument. Pour pénétrer à l'inté­
rieur de l'Instrument, double-cliquez l'objet Instrument.

2. Pour insérer une Macro d'oscillateur dans la Structure de l'Instrument, effectuez un 
[Ctrl]+clic (Mac OS® X) ou un clic droit (Windows®) dans une zone vide de la Struc­
ture de l'Instrument et sélectionnez l'entrée Macro > Building Blocks > Oscillators > 
Osc (pls, saw, tri). Un oscillateur Osc 3 Wave apparaît alors dans la Structure et dans 
le Panel de l'Instrument.
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3. Dans la Structure de l'Instrument, connectez la sortie Out de la Macro Osc 3 Wave à 
l'entrée de l'Audio Voice Combiner ; pour ce faire, tirez un câble entre les deux points
comme nous l'avions fait entre l'Instrument et les terminaux Audio Out.

Fig. 7.10 L'oscillateur connecté à l'Audio Voice Combiner.
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7.3.2 Insérer l'enveloppe ADSR
 

▪ Effectuez un [Ctrl]+clic (Mac OS® X) ou un clic droit (Windows®) sur une zone vide 
de la Structure de l'Instrument et sélectionnez l'entrée Macro > Building Blocks > En­
velopes > ADSR – Env dans le menu déroulant.

Fig. 7.11 Insertion d'une enveloppe ADSR.

7.3.3 Insérer les Modules Pitch et Gate
 

Il nous faut encore ajouter quelques composants – ou « Modules » dans la terminologie de
REAKTOR. Les Modules Note Pitch et Gate nous permettront de jouer sur ce synthétiseur 
depuis notre clavier MIDI.
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1. Effectuez un clic droit (Windows®) ou un [Ctrl]+clic (Mac OS® X) sur une zone vide 
dans la Structure de l'Instrument et sélectionnez l'entrée Built-In Module > MIDI In > 
Note Pitch dans le menu contextuel pour insérer le Module NotePitch dans la Struc­
ture.

2. Faites de même en choisissant Built-In Module > MIDI In > Gate pour le Gate (!).
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7.3.4 Connecter les Modules Pitch et Gate
 

Nous devons maintenant connecter ces Modules afin de pouvoir jouer sur notre synthéti­
seur tout frais.
1. Connectez de la manière habituelle (par glisser-déposer) le Module NotePitch à l'en­

trée P (Pitch) de la Macro Osc 3 Wave.
2. Connectez ensuite le Module Gate à l'entrée G (Gate) de la Macro ADSR-Env.
3. Enfin, connectez la sortie supérieure de l'ADSR-Env à l'entrée A (Amplitude) de la 

Macro Osc 3 Wave.
Notre synthé doit maintenant ressembler à ceci :

Fig. 7.12 Votre synthétiseur avec toutes ses connexions.

7.3.5 Niveau de sortie sans danger
 

Avant de jouer sur notre synthétiseur, nous devons vérifier que le niveau de sortie reste rai­
sonnable.
1. Pour ce faire, commencez par aller dans le Panel de l'Ensemble en cliquant sur le 

bouton Panel.

2. Jetez un œil au Panel de l'Instrument Master et ramenez la tirette Level à -10.
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Fig. 7.13 Utilisez l'Instrument Master pour régler un niveau de sortie sans risque.

Jouez maintenant quelques notes, et vous devriez entendre l'oscillateur changer de pitch 
(hauteur tonale), se déclencher et s'interrompre lorsque vous appuyez sur les touches de 
votre clavier !

7.4 Insérer le filtre
 

L'étape suivante consiste à ajouter une Macro de filtre.

7.4.1 Insérer la Macro de filtre et recâbler le tout
 

1. Vérifiez que vous vous trouvez bien dans la Structure l'Instrument. Si vous avez son 
Panel présentement sous les yeux, cliquez d'abord sur le bouton Structure.

2. Double-cliquez ensuite sur l'objet Instrument pour pénétrer dans sa Structure.
3. Effectuez un [Ctrl]+clic (Mac OS® X) ou un clic droit (Windows®) sur une zone vide 

de la Structure de l'Instrument et sélectionnez l'entrée Macro > Building Blocks > Fil­
ters > 4 Pole Filter (BP, BLP, LP) dans le menu contextuel.
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Nous devons maintenant modifier quelque peu les câblages.
1. Via la méthode usuelle du glisser-déposer, connectez la sortie de la Macro Osc 3 Wa­

ve à l'entrée In de la Macro 4-Pole Filter.
2. Connectez ensuite la sortie Out du 4-Pole Filter à l'entrée de l'Audio Voice Combiner 

(le crochet fermant « } »).
Votre synthétiseur doit maintenant ressembler à ceci :

Nous avons inséré la Macro du filtre dans la Structure de l'Instrument. Portons maintenant 
notre attention sur le Panel de l'Instrument. Vous y remarquez que les Macros sont empi­
lées les unes sur les autres. Nous allons y remédier en déverrouillant le Panel.
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▪ Pour voir le Panel de l'Instrument, cliquez sur le bouton Panel.

Fig. 7.14 Le bouton Panel.

7.4.2 Déverrouiller le Panel pour déplacer les Macros
 

Après avoir déverrouillé le Panel, vous pourrez déplacer les Macros afin qu'elles ne se su­
perposent plus.
1. Cliquez sur le bouton Panel Lock pour déverrouiller le Panel. Vous pouvez également 

utiliser le raccourci clavier [Ctrl]+[P] (Windows®) ou [Cmd]+[P] (Mac OS® X) pour 
verrouiller/déverrouiller le Panel.

Votre synthé doit maintenant ressembler plus ou moins à ceci :
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7.5 Ajouter un second oscillateur et un mixeur
 

Nous allons maintenant ajouter un second oscillateur pour rendre le son plus gros. Nous 
allons également ajouter un mixeur et effectuer toutes les connexions nécessaires.

7.5.1 Ajouter un second oscillateur via la commande Duplicate
 

Au lieu d'ajouter un nouvel oscillateur, nous allons dupliquer celui déjà présent.
▪ Revenez dans la Structure de l'Instrument, effectuez un [Ctrl]+clic (Mac OS® X) ou 

un clic droit (Windows®) sur la Macro Osc 3 Wave et sélectionnez l'entrée Duplicate 
dans le menu contextuel.
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Fig. 7.15 Duplication de l'oscillateur.

Une copie est placée au dessus de la Macro Osc 3 Wave originale.

7.5.2 Utiliser les Properties pour renommer les Macros des oscillateurs
 

Les deux oscillateurs ont le même nom, il nous faut les renommer.
1. Effectuez un [Ctrl]+clic (Mac OS® X) ou un clic droit (Windows®) sur la Macro Osc 3 

Wave et sélectionnez l'entrée Properties dans le menu contextuel. L'onglet Properties 
s'ouvre pour cette Macro.

Construire un synthétiseur à partir de Macros
Ajouter un second oscillateur et un mixeur

 

REAKTOR 5.5 - Prise en main - 101



2. Dans le champ du nom, sélectionnez le texte, saisissez « Oscillator 1 » puis appuyez
sur [Entrée].

3. Faites de même avec l'autre oscillateur et nommez-le cette fois Oscillator 2.

Fig. 7.16 Saisie d'un nom dans le champ de nom de l'onglet Properties.
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7.5.3 Ajouter un mixeur
 

Maintenant que nous avons nos deux oscillateurs, il nous faut un mixeur pour avoir une 
certaine flexibilité dans leurs niveaux respectifs. Le Module Amp/Mixer est celui qu'il nous 
faut. Nous devrons effectuer les connexions et augmenter le nombre d'entrées du mixeur.

▪ Pour insérer le mixeur, effectuez un [Ctrl]+clic (Mac OS® X) ou un clic droit (Win­
dows®) dans une zone vide la Structure de l'Instrument et sélectionnez l'entrée Built-
In Module > Signal Path Amp/Mixer.

Fig. 7.17 Insertion d'un mixeur.

Nous devons connecter la sortie des Oscillators 1 et 2 au mixeur.
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▪ Cliquez sur la sortie de l'Oscillator 1 et tirez un câble vers l'entrée In du Module Mi­
xer.

Fig. 7.18 L'Oscillator 1 connecté au Mixer.

7.5.4 Augmenter le nombre d'entrées du Mixer
 

Comme vous pouvez le constater, le Mixer n'a pour l'instant qu'une seule entrée. Nous 
pouvons toutefois créer une seconde connexion.

▪ Pour créer une seconde connexion, effectuez un [Cmd]+glisser (Mac OS® X) ou [Ctrl]
+glisser (Windows®) (autrement dit, glissez la souris tout en maintenant la touche 
[Cmd] ou [Ctrl] enfoncée) depuis le port de sortie de l'Oscillator 2 vers le bord vert en 
bas du Module Mixer. Lorsque vous atteignez ce dernier, un nouveau port est créé et 
la connexion se fait avec ce nouveau port.

Après avoir connecté la sortie du Mixer au 4-Pole Filter, votre synthétiseur doit ressembler 
à ceci :
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Fig. 7.19 Le Mixer connecté aux deux Oscillators et au Filter.

7.5.5 Ajouter des Faders et les connecter au Mixer
 

Nous devons ajouter quelques Faders pour contrôler les niveaux de chaque Oscillator.
▪ Effectuez un [Ctrl]+clic (Mac OS® X) ou un clic droit (Windows®) sur une entrée Lvl 

du Module Mixer et sélectionnez l'entrée Create Control dans le menu contextuel. Ce­
ci crée un Fader (une tirette).

Fig. 7.20 Utilisation du menu contextuel pour créer un contrôle à une entrée.
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Fig. 7.21 Le Fader connecté.

Faites la même chose avec la seconde entrée Lvl du Mixer et vous avez ainsi deux Faders.

7.5.6 Utiliser la commande Duplicate pour ajouter une seconde enveloppe ADSR
 

Avant de faire du rangement, nous allons dupliquer l'enveloppe ADSR afin de pouvoir mo­
deler l'enveloppe du filtre. Petit rappel : effectuez un [Ctrl]+clic (Mac OS® X) ou un clic
droit (Windows®) sur la Macro ADSR-Env puis sélectionnez la commande Duplicate dans 
le menu déroulant. Après avoir connecté la seconde Macro ADSR-Env à l'entrée PM (Pitch 
Modulation) du 4-Pole Filter, la Structure doit ressembler à ceci :
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Fig. 7.22 La Structure avec une seconde enveloppe ADSR connectée.

7.5.7 Connecter le Module NotePitch aux enveloppes ADSR et au filtre
 

Il nous reste quelques connexions importantes à faire. Le Module NotePitch a besoin 
d'être connecté à toutes les entrées P (Pitch) des Macros. Ceci recrée les caractéristiques 
réelles des instruments, dans lesquels plus la note est élevée, plus le son est clair et bref.

▪ Pour ce faire, cliquez sur la sortie rouge du Module NotePitch, maintenez le bouton 
de la souris enfoncé et tirez des câbles vers toutes les entrées P des Macros ADSR-
Env et 4-Pole Filter. Votre Structure doit maintenant ressembler à ceci :
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Fig. 7.23 Les connexions supplémentaires pour le Module NotePitch.

7.5.8 Réordonner le Panel de l'Instrument
 

Il est grand temps de faire un peu de rangement. Souvenez-vous : un clic sur le bouton
Panel Lock déverrouille le Panel.

Fig. 7.24 Le bouton Panel Lock.

Vous pouvez alors saisir les Macros par leur label. Le label de l'élément sélectionné est 
écrit en rouge. Vous pouvez également sélectionner plusieurs éléments à la fois en dessi­
nant un rectangle autour de tous les éléments que vous souhaitez sélectionner, ou bien en 
utilisant le [Maj]+clic. Déplacez les Macros de manière à approcher l'image suivante :
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Fig. 7.25 Le Panel de votre synthé après avoir réordonné les Macros.

Renommer les enveloppes ADSR
Comme vous pouvez le constater, nos deux Macros ADSR-Env ont le même nom. Nous al­
lons renommer la seconde enveloppe ADSR afin de savoir qu'elle module le filtre. Pour ce 
faire, utilisons les Properties de la Macro.
1. Dans la Structure de l'Instrument, effectuez un [Ctrl]+clic (Mac OS® X) ou un clic 

droit (Windows®) sur la Macro ADSR-Env connectée à la Macro Filter et sélectionnez 
l'entrée Properties dans le menu contextuel.
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2. Dans le champ du nom, sélectionnez le texte, saisissez « Filter Env » puis appuyez  
sur [Entrée].

7.5.9 Modifier l'apparence des Faders
 

Dans REAKTOR, vous pouvez modifier l'apparence des Faders afin qu'ils soient représen­
tés sous la forme de curseurs rotatifs. Les curseurs prennent moins de place, ce qui peut 
s'avérer pratique. Si vous êtes content(e) avec les Faders, vous pouvez sauter cette sec­
tion. Pour modifier l'apparence, nous allons à nouveau utiliser les Properties de REAKTOR 
et cliquer cette fois sur le bouton View.
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1. Effectuez un [Ctrl]+clic (Mac OS® X) ou un clic droit (Windows®) sur l'un des Faders 
pour ouvrir ses Properties.

2. Cliquez maintenant sur le bouton View pour ouvrir la page View.

3. Passez le Style Selector de Vertical Fader à Knob.

4. Faites de même avec l'autre Fader. Tant que nous y sommes, nous pouvons égale­
ment renommer les deux curseurs en Osc 1 Level et Osc 2 Level.
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7.6 Jouer sur votre synthétiseur et modifier le son
 

Nous pouvons maintenant explorer notre synthétiseur, modifier les réglages du filtre et des 
oscillateurs et créer des Snapshots. Enfin, nous devrons sauvegarder notre travail.

7.6.1 Changer la forme d'onde des oscillateurs, réinitialiser le filtre et le niveau de 
sortie

 

Vous trouverez peut-être que le synthétiseur a un son un peu sourd. Nous vous suggérons 
de passer la forme d'onde des Oscillators sur Saw (dent de scie) via le commutateur Wave 
et de tourner le contrôle Cutoff du Filter dans le sens horaire.
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Fig. 7.26 Les réglages modifiés du Filter et des Oscillators.

▪ Vous pouvez également ramener le niveau de sortie global à -20.

Fig. 7.27 Un niveau de sortie plus sûr.

7.6.2 Créer des Snapshots
 

Essayez différents réglages pour le curseur Mod Amt du filtre. Ce curseur affecte l'ampleur 
de la modulation du filtre par l'enveloppe Filter-Env. Faites également quelques essais 
avec les curseurs A, D, S et R – Attack (attaque), Decay (déclin), Sustain (maintien) et Re
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lease (relâchement) – dans les deux enveloppes. La modification des réglages relatifs des
paramètres Pitch et Osc Level des deux Oscillators peut également s'avérer intéressante ! Une
fois que vous avez trouvé des réglages qui vous plaisent, enregistrez-les comme Snapshot. 
Souvenez-vous, nous l'avons déjà fait lorsque nous avons exploré les synthétiseurs 2-Osc 
et Junatik.
1. Dans le Sidepane ouvert, cliquez sur l'onglet Snapshot.

2. Cliquez sur le bouton Append en bas de la liste de Snapshots.

3. Saisissez un nom pour le Snapshot puis appuyez sur [Entrée].

7.6.3 Sauvegarder votre travail via la commande Save As
 

Après avoir créé quelques Snapshots, n'oubliez pas de sauvegarder votre travail !
▪ Cette fois, nous allons utiliser le raccourci de votre système d'exploitation : sur Mac

OS® X, appuyez sur [Maj]+[Cmd]+[S], et sur Windows® appuyez sur [Ctrl]+[Maj]+[S] 
pour exécuter la commande Save Ensemble As…. Comme nous sommes partis d'un 
nouvel Ensemble, vous devrez probablement naviguer à nouveau jusqu'à votre User 
Folder.

Construire un synthétiseur à partir de Macros
Jouer sur votre synthétiseur et modifier le son

 

REAKTOR 5.5 - Prise en main - 114



8 Construire un sampler avec les Modules de REAKTOR
 

Nous allons maintenant construire un sampler (ou échantillonneur) en utilisant les Modu­
les de REAKTOR.

8.1 Plan d'action
 

▪ Nous avons déjà joué avec des samples lorsque nous avons étudié le sampler Memory 
Drum 2 de REAKTOR.

▪ Nous avons également construit un synthétiseur à partir des Macros de REAKTOR 
prêtes à l'emploi.

▪ En partant de ces connaissances, nous allons construire un sampler à partir de zéro 
en utilisant les Modules de REAKTOR.

8.2 Quelle sorte de sampler ?
 

Nous allons construire un sampler idéal pour la lecture des boucles vocales, des textures 
bourdonnantes et autres effets sonores.
Les samples pourront être lus en avant, en arrière, et en avant/arrière.
Nous utiliserons le Module Sampler de base de REAKTOR. Nous utiliserons une enveloppe 
ainsi qu'un Module Filter et connecterons les contrôles tels que Attack, Decay, Sustain et 
Release pour l'enveloppe et Cutoff et Resonance pour le filtre.
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Fig. 8.1 Le sampler une fois achevé.

8.3 Construire la Structure de base
 

Nous allons commencer plus ou moins de la même manière que lorsque nous avons cons­
truit notre synthétiseur. Nous devons donc d'abord créer un nouvel Ensemble.

8.3.1 Charger un nouvel Ensemble
 

▪ Cliquez sur le bouton Menu et sélectionnez l'entrée File > New Ensemble.
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Fig. 8.2 Création d'un nouvel Ensemble.

À cette occasion, nous allons utiliser l'Instrument Stereo In / Stereo Out par défaut. Ceci 
nous laissera la possibilité de modifier notre sampler ultérieurement en lui donnant deux 
sorties (gauche et droite).

8.3.2 Insérer les premier Modules
 

Nous allons maintenant insérer le Module Sampler ainsi que des Modules Pitch et Gate.
1. Rendez-vous dans la Structure de l'Ensemble en cliquant sur le bouton Structure.
2. Comme nous l'avons déjà vu, un double-clic sur l'Instrument dans la Structure de 

l'Ensemble ouvre sa propre Structure, nous permettant d'y insérer des Modules.
3. Effectuez un [Ctrl]+clic (Mac OS® X) ou un clic droit (Windows®) dans une zone vide 

de la Structure de l'Instrument et sélectionnez Built-In Module > Sampler > Sampler 
dans le menu contextuel.
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4. Insérez ensuite les Modules NotePitch et Gate. Rappelez-vous, nous l'avons déjà fait 
lorsque nous avons construit notre synthétiseur. Choisissons donc l'entrée Built-In 
Module > MIDI In > NotePitch puis, au même endroit, l'entrée Built-In Module > MI­
DI In > Gate.

Votre Structure doit maintenant ressembler à ceci :
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8.3.3 Insérer l'enveloppe
 

Nous allons ensuite insérer une enveloppe ADSR et des contrôles pour ses paramètres At­
tack, Decay, Sustain et Release.
Effectuez un [Ctrl]+clic (Mac OS® X) ou un clic droit (Windows®) dans une zone vide de 
la Structure de l'Instrument et sélectionnez l'entrée Built-In Module > LFO, Envelope > 
ADSR.
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Fig. 8.3 Insertion du Module ADSR.

8.3.4 Ajouter des contrôles pour l'enveloppe
 

Pour créer les contrôles, nous allons utiliser la même technique que celle que nous avions 
utilisée pour les Faders du Mixer dans notre synthétiseur.
1. Pour ajouter un Fader pour l'Attack de l'Envelope, effectuez un [Ctrl]+clic (Mac OS® 

X) ou un clic droit (Windows®) sur le A ou sur le point rouge situé à proximité, puis 
sélectionnez l'entrée Create Control.
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2. Répétez cette procédure pour les entrées D, S et R de l'enveloppe.
Maintenant, notre Structure doit ressembler à ceci :

8.4 Effectuer les connexions
 

Nous devons maintenant connecter le sampler à nos sorties ; de même, les Modules Gate
et NotePitch doivent être connectés au sampler et à l'enveloppe ADSR ; à chaque fois,          
nous utiliserons le glisser-déposer.
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8.4.1 Connecter le sampler aux deux Audio Voice Combiners
 

1. Cliquez sur le point Out du sampler, maintenez le bouton de la souris enfoncé et tirez 
un câble vers l'Audio Voice Combiner du canal gauche (L).

2. Lorsque vous atteignez le point noir In de l'Audio Voice Combiner, relâchez le bouton 
de la souris. La connexion est effectuée.

3. Faites de même avec l'Audio Voice Combiner du canal droit (R).
À nouveau, la diode jaune confirme la connexion !

Fig. 8.4 Le sampler connecté aux Audio Voice Combiners.

8.4.2 Connecter les Modules NotePitch et Gate
 

1. Cliquez sur le point rouge du Module NotePitch, maintenez le bouton de la souris en­
foncé et tirez un câble vers l'entrée P (Pitch) du sampler.

2. Relâchez le bouton de la souris lorsque vous avez atteint le point rouge.
3. Faites de même avec le Module Gate, qui doit être connecté à l'entrée Trig du sam­

pler et à l'entrée G (Gate) de l'enveloppe ADSR.
Votre Structure doit maintenant ressembler à ceci :
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8.5 Charger un sample dans le sampler
 

Nous avons construit un sampler simple, il nous faut maintenant charger un sample pour 
vérifier qu'il fonctionne !
La première chose à faire est d'ouvrir le Sample Map Editor.

8.5.1 Ouvrir le Sample Map Editor via le menu View
 

▪ Cliquez sur le bouton Sample Map de la Sidebar.

Fig. 8.5 Le bouton Sample Map.

Vous voyez le Sample Map Editor apparaître sous l'Instrument.
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Maintenant que le Sample Map Editor est ouvert, nous suivons la même procédure que 
lorsque nous avons ajouté un sample à la table d'assignations (Sample Map) du Memory 
Drum 2.

8.5.2 Ajouter un sample dans le Sample Map Editor
 

▪ Pour ajouter un sample à la Sample Map, cliquez sur le menu déroulant Edit et sélec­
tionnez l'entrée Add.
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Fig. 8.6 Utilisation du menu Edit pour ajouter un sample.

Ceci devrait ouvrir votre dossier Audio. Nous vous suggérons de naviguer jusqu'à l'endroit 
où vous stockez vos boucles vocales, vos textures et autres effets sonores. Après avoir cli­
qué sur « Open », le sample est placé dans la Sample Map (table d'assignations).

Fig. 8.7 Le sample en place.

Maintenant, si vous jouez sur votre clavier MIDI, vous devriez entendre le sample lu à dif­
férents pitches (hauteurs tonales).
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8.6 Arranger l'apparence et déplacer les Modules
 

Il nous faut réordonner quelque peu les Modules dans le Panel de la Structure ainsi que 
leur position dans le Panel de l'Ensemble.
Nous y verrons ainsi plus clair dans la Structure et nous ferons de la place pour les pro­
chains Modules.

8.6.1 Déplacer les Modules dans la Structure
 

Commençons pas faire du rangement dans notre Structure en sélectionnant les Modules 
puis en les glissant à d'autres positions.
1. Commençons par effectuer un [Maj]+clic sur les Modules NotePitch, Sampler, les Au­

dio Voice Combiners et les Outputs L et R.

2. Glissons alors les Modules sélectionnés vers le bas et vers la gauche.
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8.6.2 Supprimer les Modules indésirables
 

1. Nous n'avons pas besoin des entrées audio L et R, supprimons-les donc.
2. Effectuez un [Maj]+clic sur les deux Modules pour les sélectionner.
3. Effectuez un [Ctrl]+clic (Mac OS® X) ou un clic droit (Windows®) sur l'un des Modu­

les sélectionnés, puis sélectionnez Delete Selection dans le menu déroulant pour reti­
rer les Modules en question de la Structure.
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Fig. 8.8 Supprimer la sélection.

8.6.3 Utiliser le bouton Panel Lock pour déplacer les curseurs
 

Dans le Panel de l'Ensemble, les contrôles de l'enveloppe ADSR sont les uns sur les au­
tres. Nous devons déverrouiller le Panel afin de les déplacer.
1. Pour voir le Panel de l'Instrument, cliquez sur le bouton Panel.

2. Cliquez sur le bouton Panel Lock pour déverrouiller le Panel.
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Le Panel de votre Instrument doit maintenant ressembler à ceci :

Fig. 8.9 Le Panel nettoyé.

8.7 Ajouter d'autres samples et modifier leurs réglages
 

Rappelez-vous, l'idée de ce sampler est d'assigner différentes boucles à différentes tou­
ches du clavier. Nous devons donc modifier la Sample Map et y ajouter d'autres samples. 
Pour ce faire, il nous faut ouvrir à nouveau le Sample Map Editor.
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8.7.1 Double-cliquer sur la forme d'onde pour ouvrir la Sample Map
 

Maintenant que nous avons arrangé l'apparence du Panel de l'Instrument, nous pouvons 
double-cliquer sur la forme d'onde du sample afin d'ouvrir le Sample Map Editor.

8.7.2 Changer les réglages du sample existant
 

Avant d'ajouter d'autres samples, nous devons effectuer quelques modifications au sample 
existant. L'idée est d'assigner nos samples aux touches blanches à partir de la note MIDI 
48.
Commençons donc par nous assurer que notre sample est lu correctement sur la note MI­
DI 48. Nous voulons également que le sample ne soit lu que sur cette note.

8.7.3 Modifier le Key-Split et la Root Key
 

1. Nous voulons que notre sample soit lu à la vitesse correcte lorsque la note MIDI 48 
est jouée. La première chose à faire est de passer la Root Note – actuellement réglée
sur 60 – à 48. Double-cliquez sur l'entrée dans la colonne Root et saisissez la nouvel
le valeur.

2. Puisque nous voulons que le sample ne soit lu que sur cette note, nous devons activer 
le Single Key Mode. Pour ce faire, sélectionnez l'entrée Single Key Mode dans le me­
nu Edit.
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3. Maintenant, vous pouvez attribuer la valeur 48 aux Key-Split L et R. Sélectionnez un 
sample, double-cliquez sur l'une des entrées dans les colonnes et lignes correspon­
dantes (L ou R) puis saisissez la nouvelle valeur. Lorsque vous avez fini, appuyez sur 
[Entrée] sur votre clavier d'ordinateur.

Le sample sera lu uniquement sur la note MIDI 48 et au pitch correct.

Fig. 8.10 Réassigner le sample.
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8.7.4 Ajouter d'autres samples
 

Nous allons ajouter un autre sample et l'assigner à la note MIDI 50.
1. À nouveau, utilisez l'entrée Add du menu déroulant Edit pour ajouter un autre sample.
2. Réglez maintenant les paramètres L et R du Key-Split de ce sample sur 50 égale­

ment.
3. Nous allons reproduire cette procédure et ajouter deux autres samples. Nous voulons 

les assigner à des touches blanches, le sample suivant devra donc avoir ses paramè­
tres L, R et Root réglés sur 52.

4. Le quatrième sample, lui, devra avoir ses paramètres L, R et Root réglés sur 53.
Maintenant, nos quatre samples seront lus via les notes C2, D2, E2 et F2 – qui correspon
dent aux notes MIDI 48, 50, 52 et 53.
Notre Sample Map doit ressembler à ceci :

Fig. 8.11 Quatre samples assignés à des touches uniques.

Si vous le souhaitez, vous pouvez assigner d'autres samples aux notes MIDI 55, 57, 59 et 
60. Dans ce tutoriel, nous passerons maintenant à l'étude de la lecture des samples. Nous 
allons apprendre à changer la direction de lecture des samples.
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8.8 Sample Reverse et autres possibilités de lecture
 

Nous allons maintenant explorer les moyens de lire les samples à l'envers et de les trans­
poser.

8.8.1 Bouclage et boutons de direction
 

Il s'agit peut-être d'un sampler basique, mais chaque sample peut tout de même avoir ses 
caractéristiques propres en termes de lecture. Penchons-nous sur certaines des fonctions 
dans le Sample Map Editor. Sous la forme d'onde du sample, vous pouvez voir les boutons 
Loop, Reverse et Alternating Loop.

Fig. 8.12 Les boutons et cases à cocher Loop, Reverse et Alternating Loop.

Comme vous pouvez le voir, ces trois fonctions sont désactivées par défaut.
1. Vérifiez que le bouton Key est activé afin de pouvoir utiliser notre clavier MIDI pour 

sélectionner les samples. Commençons par celui situé sur la note MIDI 48.
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2. Cliquez maintenant sur le bouton Loop – celui-ci s'allume.
3. Sur votre clavier MIDI, jouez la note correspondant au sample que vous êtes en train 

d'éditer et maintenez la note enfoncée. Vous devriez entendre le sample revenir à son 
début et se répéter en boucle.

4. Cochez maintenant la case Reverse.

Vous devriez entendre le sample en boucle, mais à l'envers cette fois.
Si vous cochez la case Alternate, le sample sera lu à l'envers puis à l'endroit.

Essayez d'autres combinaisons !
Chacun de vos quatre samples peut avoir ses propres réglages.

Vous pourriez également placer le même sample sur quatre notes et modifier leurs caractéris­
tiques de lecture !

8.8.2 Transposer un sample
 

Pour le moment, les quatre samples sont lus à leurs pitches originaux.
▪ Utiliser les réglages Root pour modifier leurs pitches (ou hauteurs tonales).

Dans notre exemple, nous avons transposé le sample de sept demi-tons vers le bas en dé­
calant sa note Root de sept demi-tons vers le haut.
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Fig. 8.13 Transposer un sample.

8.9 Ajouter un filtre
 

Nous allons maintenant ajouter un filtre à notre sampler et créer des contrôles pour les 
paramètres Cutoff et Resonance. Nous essaierons également différentes caractéristiques 
de filtres telles que passe-bas, passe-bande et passe-haut.

8.9.1 Insérer un filtre dans la Structure
 

Effectuez un [Ctrl]+clic (Mac OS® X) ou un clic droit (Windows®) dans une zone vide de 
la Structure de l'Instrument et sélectionnez l'entrée Built-In Module > Filter > Multi 2-Po­
le.

Construire un sampler avec les Modules de REAKTOR
Ajouter un filtre

 

REAKTOR 5.5 - Prise en main - 135



Fig. 8.14 Insertion d'un filtre.

8.9.2 Créer les contrôles du filtre et faire les branchements
 

Nous allons créer des contrôles pour les entrées P (Pitch Cutoff) et Res (Resonance).
1. Comme auparavant, effectuez un clic droit (Windows®) ou un [Ctrl]+clic (Mac OS® 

X) sur les entrées en question et sélectionnez Create Control.
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2. Connectez ensuite la sortie du sampler à l'entrée In du Multi 2-Pole et la sortie LP 
(Lowpass, passe-bas) du filtre aux deux Audio Voice Combiners.

Après avoir déplacé les Modules pour faire de la place, votre Structure doit ressembler à 
ceci :

Fig. 8.15 Le filtre avec ses contrôles dans la Structure.

8.9.3 Nettoyer l'apparence du Panel de l'Instrument
 

▪ Une fois de plus, nous devons déverrouiller le Panel pour pouvoir déplacer les cur­
seurs Cutoff et Resonance. Ainsi, ils ne seront plus empilés sur le Sampler.

Le Panel de votre Instrument doit ressembler à ceci :
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Fig. 8.16 Le Panel nettoyé.

8.9.4 Test avec les sorties passe-bande et passe-haut du filtre / sauvegarde de votre 
travail

 

Avec les samples, il est parfois plus judicieux d'utiliser les filtres passe-bande ou passe-
haut, souvent mieux adaptés que le passe-bas.
1. Mais avant cela, cliquez sur le bouton Menu et sélectionnez l'entrée Save Ensemble 

As… pour sauvegarder votre Ensemble !
2. Maintenant que votre travail est enregistré, faites quelques essais avec les différentes 

sorties du filtre. Dans la Structure de votre Instrument, cliquez sur la sortie BP du 
Multi 2-Pole et tirez des câbles vers les Audio Voice Combiners.
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3. Jouez maintenant sur votre clavier MIDI et modifiez les réglages du filtre, et pourquoi 
pas, les contrôles de l'enveloppe ADSR également.

4. Enfin, connectez la sortie HP aux deux Audio Voice Combiners. Vous pourrez alors dé­
cider quelle sortie du filtre vous convient le mieux.

5. Enregistrez votre travail.
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8.9.5 Utiliser la commande Save Ensemble pour mettre à jour votre sampler déjà 
enregistré

 

Puisque nous avons déjà utilisé la commande Save Ensemble As… pour enregistrer notre 
travail précédemment, nous pouvons utiliser ici la commande Save Ensemble pour mettre 
à jour et écraser la version précédemment enregistrée.

▪ Cliquez sur le bouton Menu et sélectionnez l'entrée File > Save Ensemble.

Fig. 8.17 Sauvegarde de l'Ensemble.

Si vous le souhaitez, vous pouvez apporter une modification au filtre pour le rendre plus 
flexible. Pour ce faire, jetez un œil à la section suivante. Si vous êtes satisfait(e) du sam­
pler tel qu'il est, vous pouvez sauter la section suivante !
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8.10 Modifier le sampler existant
 

Cette section est pour celles et ceux d'entre vous qui veulent un peu plus de flexibilité 
dans la section de filtrage du sampler.

8.10.1 Aperçu du Selector utilisé pour le fondu
 

Certains d'entre vous souhaiteront peut-être pouvoir effectuer un fondu entre les trois ty­
pes de filtres pour pouvoir choisir lequel des trois – High Pass, Band Pass ou Low Pass –
est le mieux adapté à vos samples. Si vous voulez ajouter cette fonctionnalité, voici à quoi 
ressemblera la Structure finale :

Fig. 8.18 La Structure avec le Module Selector.

Comme vous le voyez, le Selector dispose de trois entrées et d'un Fader Position.
Le Fader Position effectue le fondu entre les trois filtres, passant de Hi Pass à Band Pass 
et enfin à Low Pass. Les fondus sont souples, permettant d'avoir par exemple un mélange 
de passe-haut et de passe-bande. Voici comment créer ces fondus.

8.10.2 Insertion du Selector
 

Nous devons insérer un Module Selector et lui connecter les trois sorties du filtre. Nous 
créerons ensuite un Fader Position et connecterons la sortie du Module aux deux Audio 
Voice Combiners.
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▪ Effectuez un [Ctrl]+clic (Mac OS® X) ou un clic droit (Windows®) dans une zone vide 
de la Structure de l'Instrument et sélectionnez l'entrée Built-In Module > Signal Path 
> Selector/Scanner.

Fig. 8.19 Insertion du Module Selector.

8.10.3 Connecter les sorties du filtre
 

1. D'abord, nous devons connecter la sortie HP du filtre à l'entrée 0 du Selector.
2. Cliquez sur le point noir près de la sortie HP, maintenez le bouton de la souris enfon­

cé et tirez un câble vers le Selector.
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3. Lorsque le curseur atteint le point bleu près de l'entrée 0, relâchez le bouton de la 
souris et la connexion est établie.

L'entrée du Selector devient noire, ce qui confirme que la connexion audio a bien été 
créée.

Fig. 8.20 Le Filter et le Selector connectés.

8.10.4 Augmenter le nombre d'entrées sur le Selector
 

Nous avons besoin d'entrées supplémentaires sur le Selector afin d'y brancher les trois sor­
ties du Filter.
1. Tout en tirant le câble depuis la sortie BP vers le Selector, maintenez la touche [Cmd] 

(Mac OS® X) ou [Ctrl] (Windows®) enfoncée.
2. Lorsque vous atteignez le Selector, une nouvelle entrée est créée juste au dessous de 

la précédente et la connexion est effectuée !
3. Répétez la procédure pour connecter la sortie LP à une troisième entrée sur le Selec­

tor :
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Fig. 8.21 Les entrées du Selector connectées aux sorties du Filter.

8.10.5 Ajouter le Fader Position et modifier son intervalle
 

1. Pour ajouter le Fader au Selector, effectuez un [Ctrl]+clic (Mac OS® X) ou un clic 
droit (Windows®) sur l'entrée Pos du Selector et sélectionnez Create Control dans le 
menu déroulant.

2. Nous devons modifier l'intervalle (Range) du Fader, accessible dans ses Properties. 
Pour ouvrir celles-ci, double-cliquez sur le Fader dans la Structure.

Construire un sampler avec les Modules de REAKTOR
Modifier le sampler existant

 

REAKTOR 5.5 - Prise en main - 144



3. Rendez-vous sur la page Function des Properties du Fader en cliquant sur le bouton 
Function.

4. Ramenez maintenant le champ Max de 8 à 2.

Le Fader Position balaye désormais les valeurs entre 0, 1 et 2. En conséquence, il balaye­
ra les trois sorties du Filter.

8.10.6 Connexions finales et apparence du Panel
 

Nous devons encore connecter le Selector aux deux Audio Voice Combiners.
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▪ Tirez des câbles (de la manière habituelle) vers les entrées des Audio Voice Combi­
ners.

Après avoir créé les deux connexions et déplacé le Selector, la Structure doit ressembler à 
ceci :

Fig. 8.22 Les connexions sont faites.

▪ Enfin, déverrouillez le Panel de l'Instrument pour déplacer le Fader en cliquant sur le 
bouton Panel Lock et glissez le Fader Pos vers la droite.

Fig. 8.23 Le bouton Panel Lock.
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Fig. 8.24 Le Fader Position déplacé.

▪ Verrouillez le Panel en cliquant à nouveau sur le bouton Panel Lock.

8.10.7 Explorer votre sampler et créer quelques Snapshots
 

1. Modifiez quelques réglages de votre sampler maison et enregistrez-les en tant que 
Snapshots.
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2. Petit rappel : cliquez sur l'onglet Snapshot et utilisez la commande Append pour sauve­
garder un Snapshot.

Fig. 8.25 L'onglet Snapshot.

Fig. 8.26 Utiliser Append.
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Comme vous le savez, vous devez absolument sauvegarder à nouveau votre Ensemble pour 
enregistrer vos nouveaux Snapshots. Vous pouvez réutiliser la commande Save Ensemble 
ou bien, si vous souhaitez conserver une version antérieure du sampler – par exemple celle
sans le Selector, utilisez la commande Save Ensemble As… et choisissez un nouveau 
nom.
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9 Et ensuite ?
 

Maintenant que vous avez suivi tous les tutoriels de ce guide de Prise en Main de REAK­
TOR, vous pouvez passer aux techniques plus avancées en lisant les autres manuels livrés 
avec REAKTOR. Vous pouvez également vous tourner directement vers les forums d'utilisa­
teurs de REAKTOR sur notre site web pour obtenir les dernières astuces et profiter du 
nombre croissant de superbes Instruments et Ensembles créés par d'autres utilisatrices et 
utilisateurs.
Quoi que vous fassiez, amusez-vous bien avec REAKTOR et n'oubliez pas de partager vos 
créations avec la communauté d'utilisateurs et utilisatrices !

Et ensuite ?
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